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1. Overview

Features
New 36×24 mm Full Frame CMOS
Image Sensor
Supports image capture at resolutions up to 6048
× 4032 pixels.* By switching the imager mode, the
unit can natively support many shooting formats,
including Super 35 24.3 × 12.8 mm, 4096 × 2160
pixel resolution (equivalent to 3-perforation
motion picture film) and 4:3 Anamorphic*
Super 35 24.3 × 18.3 mm, 4096 × 3024 pixel
resolution (equivalent to 4-perforation motion
picture film).
* Full Frame and Anamorphic modes require licenses sold
separately.

Wide Latitude
The unit supports 15+ stops of latitude. It features
very low noise for delivering phenomenal images
in conditions from searing sunlight to almost
no light, allowing for unprecedented creative
freedom in grading.

PL Lens Mount

Modular design

Various Recording Formats

Equipped with the industry-standard PL lens
mount. The lens mount supports Cooke /i
technology, and lens information is recorded as
metadata frame by frame.

Features a fully modular design, allowing you
to flexibly support various rigs and peripheral
equipment according to the shooting application.
The top handle and viewfinder are easily
adjustable to maintain ergonomic balance and
ease of use with lenses. The height of the optical
axis is the same as the PMW-F55, permitting the
use of peripheral devices used with the PMW-F55.
And an optional AXS-R7 Portable Memory
Recorder can be securely attached to the rear of
the unit using four hex screws.

The unit supports recording on SxS memory cards
in XAVC and MPEG HD formats. In addition, it can
record in 16-bit RAW or X-OCN format onto AXS
memory cards when used in combination with an
optional AXS-R7 Portable Memory Recorder.

Compact Body and Intuitive
Operation
A relatively compact design for a device equipped
with a large Full Frame image sensor, achieved
using Sony’s miniaturization technology, which
allows easier shooting in confined spaces or on
drones.
The position, shape, and size of the control
buttons reflect the requirements of camera
operators for intuitive operation. They also feature
backlighting for ease of use in dark locations.

Engineered to Survive
Wide Color Space Capture
Images can be captured in a color space that
exceeds DCI-P3. The degree of freedom in the
grading is dramatically improved when using
Sony’s S-Gamut3.Cine color space together with
S-Log3.

The chassis is made from magnesium alloy for
high robustness and durability. The ventilation
system is completely isolated from all electronic
components to prevent ingress of dust, sand, and
liquids.*
The silent-running fan can be cleaned or even
swapped out on set quickly and easily to maintain
high redundancy.
* Design protects against dust and rain, but cannot
completely prevent the ingress of dust and liquid.

8-Position Optical ND Filter
Employs an 8-position optical ND filter. It offers
a wide ND range of 0.3ND (1/2 = 1 stop) to
2.4ND (1/256 = 8 stops) that reduces time lost
on set changing external ND filters. The ND filter
mechanism is servo-controlled.

Intuitive and Familiar On-Set
Operation
The menu screen is available from both sides of
the camera, with the main control display on the
Assistant side of the camera for fast access to the
camera settings by the camera assistant while
shooting.
An OLED mini display on the Operator side allows
the operator to access commonly accessed
features such as ND filter position, shutter, white
balance, and exposure index (EI), making it
convenient for the operator to check the status of
the unit.
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Effective Picture Size

Software Licenses

The unit supports shooting in the following effective picture sizes.

You can select software licenses (optional) according to the intended usage of the unit.
Software licenses are installed using Maintenance > License Options (page 51) in the full menu.

[Note]
A software license is required to shoot in 6K 3:2 and 4K 4:3.

Software license
License not required

6K 3:2

4K 4:3

Anamorphic License
Full Frame License

Imager mode
3.8K 16:9
4K 17:9
4K 4:3
6K 3:2

Effective number of pixels
3840 × 2160
4096 × 2160
4096 × 3024
6048 × 4032

[Note]
Recording in 6K 3:2 is supported, but playback is not supported.

4K 17:9
(DCI 4K)

3.8K 16:9
(Ultra HD)

W × H (mm)
22.8 × 12.8
24.3 × 12.8
24.3 × 18.3
35.9 × 24.0

Project frame rate
23, 24, 25, 29, 50, 59
23, 24, 25, 29, 50, 59
23, 24
23, 24
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System Configuration
Microphone Holder (A-2182-620-A)
Rod Clamp (A-2182-621-A)
Rod (4-684-612-01)
DVF-EL200
Viewfinder

DVF-L700
Viewfinder
(VF cable (A-2201-632-A or
A-2201-633-A) is required)

ECM-680S, ECM-678,
ECM-674
Microphone
(EC-0.5X3F5M is required)

AXS-R7
Portable Memory
Recorder

AXS-A256S24, AXS-A512S48,
AXS-A512S24, AXS-A1TS48,
AXS-A1TS24
AXS Memory Card

AXS-AR1, AXS-CR1
AXS Memory Card
Reader

SCL-PK6,
SCL-P11X15
S35 PL Lens
BP-FL75, BP-FLX75
Battery Pack

CBKZ-3610A,
CBKZ-3610AM,
CBKZ-3610AW
Anamorphic
License

Anamorphic Lens
AXS-AR1
AXS Memory Card Reader

MPC-3610

AC-DN2B, AC-DN10
AC Adaptor
SBAC-US30/UT100
USB Card Reader
CBKZ-3610F,
CBKZ-3610FM,
CBKZ-3610FW
Full Frame License

Full Frame Lens

VCT-FSA5
Shoulder Adaptor

SBP-256D, SBP-128B/C/D, SBP-64A/B/C/D, SBP-32,
SBS-64G1A/B, SBS-32G1A/B
SxS Memory Card
QD-S64E, QD-S32E, QD-N64, QD-M128A, QD-M64A,
QD-M32A, QD-G128A/E, QD-G64A/E, QD-G32A/E
XQD Memory Card
(QDA-EX1 XQD ExpressCard Adaptor is required)
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Location and Function of Parts
8. Power switch

Operator Side
Air inlet

12

3

Set to the ON position () to turn the power on.
Set to the OFF position () to turn the power
off.

SxS memory card
slot block (page 7)

[CAUTION]
ˎˎ This unit uses a small amount of standby power
even when the power switch is set to OFF. Remove
the battery pack if the unit will not be used for a
prolonged period.
ˎˎ When removing the battery pack or the DC IN
power, be sure to first set the power switch to the
OFF position. Interrupting the power supply during
recording or during memory card access could cause
a malfunction.

4

5

9. HOME button
Press to clear the item selection display and
return to the Home screen on the mini display .
If pressed when the unit is in playback state,
the unit transitions to shooting mode
(page 55).

16

10. LOCK switch

15
14

Locks the operation of the buttons on the
Operator side. When locked, the switch
background LED lights in orange.

11. Headphones connector (stereo mini jack)

13 12 1110 9 8 7
1. ASSIGN (assignable) buttons 1/2 (page 32)
Assign functions using the EDIT page of the
user functions screen (page 32).
The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

2. ASSIGN (assignable) lamps 1/2 (page 32)
Each lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

3. Mini display ITEM keys 1 to 3
Controls the operation of functions on the
mini display (page 55).

6

4. Mini display
Displays various setup items, such as shutter
angle, that you can check or modify
(page 55).

5. ACCESS lamps (SLOT A/B)
Each lamp is lit when the recording media in
SxS card slot A/B is the target for recording/
playback and when data is being written to or
read from the recording media in SxS card slot
A/B (page 21).

6. Network connector (RJ-45)
Not supported in firmware version 1.0.

7. CLIPS button
Not supported in firmware version 1.0.

Connect to earphones for audio monitoring.
You can monitor the input audio during
shooting/recording and playback sound
during playback (page 54).

12. Built-in speaker
You can monitor the input audio during
shooting/recording and playback sound
during playback. The speaker also sounds
alarms to reinforce visual warnings
(page 54).
If you connect earphones to the headphones
jack, the speaker output is suppressed
automatically.

13. REC ACTIVE lamp
The lamp is lit green when the REC button is
enabled.

14. ASSIGN (assignable) lamp 3 (page 32)
The lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

15. REC (recording start/stop) button/lamp
Press to start recording, turning the REC lamp
on. Press again to stop recording, turning the
REC lamp off (page 57).
The REC lamp flashes when a device error or
warning occurs.

16. ф mark
The ф mark is on the same plane as the image
sensor.
To measure the precise distance between the
unit and the subject, use the ф mark as a
reference.
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SxS memory card slot block (page 21)

the tape measure hook as a reference. You can
attach the end of a tape measure to the hook,
and measure the distance from the subject.

Assistant Side

The SxS memory card slots are located behind the
cover.

1 23

6. HOME button

4

1

Press to clear the display and return to the
Home screen on the sub display (page 29).
If pressed when the unit is in playback state,
the unit transitions to shooting mode.

5
1

2

2

3

18

6

17

7
4

5

6

3

8
9

1. SxS memory card slots A/B

16 14 12
15 13 11 10

2. Manufacturer calibration terminal
Manufacturer terminal for calibration and
servicing (cannot be used by users).

3. SLOT SELECT (SxS memory card select)
button
Press to switch the active slot.

1. ASSIGN (assignable) button 4 (page 32)
Assign functions using the EDIT page of the
user functions screen (page 32).
The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

2. ASSIGN (assignable) lamp 4 (page 32)
The lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

3. Sub display
Allows you to check the operation status of
the unit and make various settings
(page 27).

With the Home screen displayed, press and
hold the BACK button (page 8) and turn
the SEL/SET dial to adjust the brightness of the
sub display and mini display.
The brightness can also be adjusted using
Technical > Control Display > Brightness level
(page 50) in the full menu.

4. Sub display ITEM keys 1 to 6
Controls the operation of functions on the sub
display (page 35).

5. Tape measure hook
The tape measure hook is on the same plane
as the image sensor. To measure the precise
distance between the unit and the subject, use

7. MENU (menu display on/off) button
(pages 35, 41)
Press the MENU button to display the menu
screen on the sub display. Press and hold the
MENU button for 2 seconds or longer to
display the full menu screen on the sub
display. Press the button during menu screen
or full menu screen display to return to the
previous screen display.

8. SEL/SET (select/set) dial (MENU dial)
Changes the item selection or a setting within
the menu (pages 29, 35, 41).

9. +48V power lamp
Lights in green if the AUDIO IN switch is set to
MIC and +48 V phantom power is supplied on
the AUDIO IN connector. It is not lit if phantom
power is not supplied.
You can turn +48 V phantom power on/off
using Audio category > Audio Details > Audio
Configuration > Phantom Power +48V
(page 48) in the menu.

10. AUDIO IN (audio selector) switch
Select the input signal type corresponding to
the audio source connected to the AUDIO IN
connector.
LINE: When connecting an external analog
audio signal source
AES/EBU: When connecting an external digital
audio signal source
MIC: When connecting a microphone.
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11. AUDIO IN connector (XLR 5-pin)
Input external microphone or audio
equipment signals.
When the audio source is set to LINE or MIC
using the AUDIO IN switch, this connector
functions as the AUDIO IN CH-1 and AUDIO IN
CH-2 connector.
When the audio source is set to AES/EBU using
the AUDIO IN switch, this connector functions
as an AUDIO IN CH-3/4 connector.

18. USER button
Press to display the user function list on the
sub display, and to operate the ITEM keys 1 to
5 user function buttons.
ITEM key 6 is the user function list EDIT button.
Press this button to display the function
selection screen for the user function buttons
and assignable buttons. Press again when the
user functions screen is displayed to return to
the previous display (page 32).

Front

12. BACK button
Cancels the menu setting and moves up one
level in the menu hierarchy during menu
display. Cancels the execution process or
pending process during process execution/
pending display (pages 29, 35, 41).

5
4

13. LOCK switch

1

Locks the operation of the buttons on the
Assistant side. When locked, the switch
background LED lights in orange.

14. ACCESS (SD card access) lamp (page 23)

3

15. REC ACTIVE lamp
The lamp is lit green when the REC button is
enabled.

16. REC (recording start/stop) button/lamp
Press to start recording, turning the REC lamp
on. Press again to stop recording, turning the
REC lamp off (page 57).
The REC lamp flashes when a device error or
warning occurs.

17. CLIPS button
Press to display the clip list screen on the sub
display to enable clip operations (page 52).
To switch from playback mode to shooting
mode, press the HOME button.

1. ASSIGN (assignable) button 3 (page 32)
Assign functions using the EDIT page of the
user functions screen (page 32).
The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

2. PL lens mount adaptor (page 17)
3. VF (viewfinder output) connector
(page 19)

4. LENS connector (12-pin)
Not supported in firmware version 1.0.

2
5. 24V OUT connector (DC OUT 24 V, Fischer
3-pin)
24 V DC power supply output connector
(page 59).
The output voltage and maximum output
current of this connector vary depending on
the input voltage to the unit. The maximum
current includes the output current from the
24V OUT connector on the rear panel
(page 9).
11 V to 17 V input
Output voltage : 24 V
Maximum output current: 1.0 A
22 V to 32 V input
Output voltage: Same as the input voltage
Maximum output current: 2.0 A
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Digital signal and analog signal input are
supported.
Digital signal: 1.5G HDSDI interlaced signal
Analog signal: HD sync, Analog

Rear

13
12
11
10
9

1
2
3
4
5
6
7

5. TC IN (timecode input) connector (BNC type)
To lock the timecode of the unit to an external
source, input a reference timecode signal.

6. AUX connector (LEMO 5-pin)
Outputs the timecode signal (page 60).

7. REMOTE (remote control) connector (8-pin)
Not supported in firmware version 1.0.

8. 12V/24V (DC power input) connector
(page 14)
DC power supply input connector for external
power supply to the unit. Supports 12 V and
24 V input voltages.

8
1. 24V OUT connector (DC OUT 24 V, Fischer

2. 12V OUT connector (DC OUT 12V, Hirose

3-pin)
24 V DC power supply output connector
(page 59).
The output voltage and maximum output
current of this connector vary depending on
the input voltage to the unit. The maximum
current includes the output current from the
24V OUT connector on the front panel
(page 8).

4-pin)
12V DC power supply output connector
(page 59).
The output voltage and maximum output
current of this connector vary depending on
the input voltage to the unit.

11 V to 17 V input
Output voltage : 24 V
Maximum output current: 1.0 A

22 V to 32 V input
Output voltage : 15 V
Maximum output current: 0.8 A

22 V to 32 V input
Output voltage: Same as the input voltage
Maximum output current: 2.0 A

11 V to 17 V input
Output voltage: Same as the input voltage
Maximum output current: 1.0 A

3. MONITOR OUT connector (BNC type)
HD SDI monitor signal output connector
(page 59).

4. GENLOCK (genlock input) connector (BNC
type)
To genlock the unit to an external source or to
lock the timecode of the unit to an external
source, input an external reference signal.

No.
1

Signal
GND

2

NC

3

NC

4

DC IN (11 V to 17 V or 22 V to 32 V)

9. Battery attachment terminal (page 14)
10. SDI OUT 1 to 4 (serial digital output)
connectors (BNC type) (page 59)

11. Battery pack mount (page 14)
12. Battery release lever (page 14)
13. HDMI OUT connector (page 59)

000
10
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Top

Bottom
1 23

4

1

2

Air vent

1. External device connector
Not supported in firmware version 1.0.

2. Release button (page 16)
3. Handle/VF attachment mount (page 16)
4. Accessory mounting screw holes
Type of screw: 1/4-20UNC (8)
Type of screw: 3/8-16UNC (10)
Length of engagement: 10 mm (3/8 inch) or
less

1. Tripod plate attachment holes
Type of screw: 1/4-20UNC (2)
Type of screw: 3/8-16UNC (4)
Length of engagement: 9 mm (3/8 inch) or less

2. Bottom cover
Remove the four hex screws to remove the
cover.

3. SD card slot (page 23)

3
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1. Overview: Location and Function of Parts

6. Exposure index indicator

Viewfinder Screen

Displays the exposure index (EI) value.

During shooting (recording or standby) and playback, the status and settings of the unit are
superimposed over the picture on the viewfinder screen.

2

Fixed-24 FPS

31

Displays the selected Look (page 43).

3 45 6

18 0 . 0

ND 2 . 4

9. Battery capacity/voltage indicator

7 8 9

1250 EI

Displays the following indicators according to
the type of battery power source.

3200 +0. 02
BAT 120 min
Look Info:R709 (800%)

4K

VF
R709

4:3

D.Spd

2.0x

Peak
Zebra

30
29 28
27
26
25

SxS
LOG
Sub
Look

SDI 1/2
LOG
SDI 3/4
Look

MPG

MON
R709
HDMI
R709

14.5

SDI
Stop

mm

7.9

10 11
12 13
14
15
16
17
18

ft

T2.8
12:34:56:00

24

A001C001

Rec

X-OCN ST / MPEG 422

23 22

Displays the color temperature and Tint value
of the white balance.

8. Look information display

Information displayed on the screen while recording

1

7. Color temperature indicator

AXS A 120 min

21

SxS B 180 min

1

2

19

20

Battery type

InfoLithium
battery

Display
Battery remaining capacity
and remaining recording
time
Remaining battery capacity
(% indicator)

Anton/Bauer
battery
Other batteries Input voltage

10. VF LUT indicator
Displays the viewfinder LUT (page 42).

11. VF Double Speed Scan indicator
Displays the on/off state of the function for
doubling the frame rate of the viewfinder
display.

12. VF Peaking indicator
1. Recording frame rate indicator
Displays the recording frame rate and project
frame rate.

2. Shutter angle/shutter speed indicator
Displays the shutter angle or shutter speed of
the electronic shutter.

3. ND filter indicator
Displays the density of the ND filter. The
display value is a LOG (base 10) value
(page 42).
0.3: 1/2
0.6: 1/4
0.9: 1/8
1.2: 1/16
1.5: 1/32

1.8: 1/64
2.1: 1/128
2.4: 1/256

4. Thermometer icon
Displayed when a high temperature warning
message is issued.
The description is displayed in the Info
category in the menu.

5. Warning icon
Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.

Displays the on/off state of the peaking
function of the viewfinder display.

13. VF Zebra indicator
Displays the on/off state of the zebra function
of the viewfinder display (page 33).

14. SDI OUT 1/2 connector LUT indicator
Displays the LUT setting of the SDI OUT 1/2
connectors (page 42).

15. SDI OUT 3/4 connector LUT indicator
Displays the LUT setting of the SDI OUT 3/4
connectors (page 42).

16. Monitor LUT indicator
Displays the LUT setting of the Monitor output
(page 42).

17. HDMI LUT indicator
Displays the LUT setting of the HDMI output
(page 42).
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18. SDI output REC trigger indicator

25. Iris position indicator

Displays the SDI output REC trigger status.
State
Technical > System Configuration > SDI Rec Remote
Trigger in the full menu
Off
HD SDI Remote I/F

Display
Recording command
superimposed on the
SDI output
–
Stop command
Rec command

Parallel Rec

Stop command
Rec command

19. Audio level meter indicators
Displays the levels of audio channels 1 and 2
while recording.

20. Recording media state/remaining capacity
indicator for each media slot
Displays the state and remaining capacity of
the media in SxS memory card slots A/B and
AXS memory card slots A/B.
A mark on the left of “AXS” or “SxS” indicates
the recording target media.
An indicator on the upper right of the slot
A/B icon on the right of “AXS” or “SxS” indicates
the playback target media (green indicator
indicates media is being played).
A
icon is displayed for media if a condition
occurs that could impact recording.

26. Focus position indicator
(Blank)
Top: SDI
Bottom: Stop
Top: SDI
Bottom: REC
Top: SDI-P
Bottom: Stop
Top: SDI-P
Bottom: REC

21. Recording media format (codec) indicator
Displays the format of the recording on an AXS
memory card or an SxS memory card .

22. Recording status indicator
Displays the following recording operation
states of the unit.
Display

ˎRec
Stby

Displays the iris position (only when a lens that
is compatible with the iris setting display
function is attached).

Description
During recording
Recording standby

23. Clip name display
Displays the first 8 characters of the name of
the next clip to be recorded in recording
standby mode.
Displays the first 8 characters of the name of
the clip currently being recorded when
recording.

24. Time data display
Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 36).

Displays the focus position (only when a lens
that is compatible with the focus setting
display function is attached).

27. Zoom position indicator
Displays the focal length of the zoom
(displayed only when a lens that supports the
zoom setting indicator is attached).

28. Simultaneous recording status indicator
Displays the sub clip recording format in 1-slot
simultaneous recording mode (page 58).

29. SxS Sub LUT indicator
Displays the LUT setting to register for a sub
clip in SxS 1-slot simultaneous recording
mode.

30. SxS LUT indicator
Displays the LUT setting for SxS recording.

31. Effective picture size indicator
Displays the effective picture size and whether
anamorphic de-squeeze conversion is applied,
set using Project category > Imager Mode in
the menu (page 36).
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Information displayed on the playback screen
The following information is displayed on the playback picture.

78
BAT 120 min

12:34:56:00

A001C001

1

2

Play

3

XCON ST

AXS A

4

5

1. Time data display
Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 36).

2. Playback clip name display
Displays the first 8 characters of the name of
the playback clip.

3. Playback status indicator
Displays the playback status.

4. Playback media format (codec) indicator
Displays the recording format (codec) of the
playback clip.

5. Playback media indicator
Displays the type of recording media being
played.
A icon appears on the right if the memory
card is write-protected.

1

2

6

6. Audio level meter indicators
Displays the levels of audio channels 1 and 2
during playback.

7. Thermometer icon
Displayed when a high temperature warning
message is issued.
The description is displayed in the Info
category in the menu.

8. Warning icon
Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.

000
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2. Preparation

Preparing a Power Supply
You can use a battery pack or AC power via an AC
adaptor.
For safety, use only the Sony battery packs and AC
adaptors listed below.

Lithium-ion battery pack
BP-FL75
BP-FLX75

AC adaptor
AC-DN2B
AC-DN10

Using a Battery Pack
Insert the battery pack into the battery pack
mount (page 9) of the battery adaptor, then
slide the battery pack down to lock it in place.
To remove it, unlock the battery pack by sliding
it up while pressing the battery release lever
(page 9), then remove it.
[Notes]
ˎˎ Before use, charge the battery pack with the battery
charger.
ˎˎ A warm battery pack immediately after use may not be
able to be fully recharged.
ˎˎ Remove the battery adaptor while supporting the unit
by hand.

Checking the remaining battery charge
When recording or playback is in progress using
the battery pack, an icon to show the current
battery remaining time and battery voltage are
displayed on the sub display screen (page 27)
and viewfinder screen (page 11).
The unit indicates the remaining usage time in
minutes by calculating the available time with
the battery pack if operation is continued at the
current rate of power consumption.

If the remaining battery charge becomes low
If the remaining battery charge decreases to a
certain level during operation, the remaining
battery capacity indicator flashes and the REC
lamp flashes to warn you.
If the remaining charge further decreases to a
level at which operation cannot be continued, a
battery-empty message appears.
Replace the battery pack with one that is fully
charged.

To change the message levels
Change levels using Technical > Battery
(page 49) in the full menu.

Using AC Power (DC IN Power)
The unit works with AC power using the AC-DN10
(optional) or AC-DN2B AC adaptor (optional) and
CCDD-X2 DC cable (optional).
11 V to 17 V and 22 V to 32 V input voltage ranges
are supported.
[Note]
When switching to the DC IN power supply during battery
operation, use a power supply with a voltage in the range
12 V to 17 V or 22 V to 32 V.

000
15

2. Preparation

Setting the Clock
When you use the unit for the first time, the initial
setup screen appears on the sub display when the
power is turned on.
Set the date and time of the built-in clock using
this display.

Time Zone
The value shows the time difference from UTC
(Coordinated Universal Time). Change the setting
if needed.
[Note]
When Time Zone is changed, the clock setting changes
according to the time difference.

Setting the Date and Time
Turn the MENU dial (page 7) to move the
cursor, then press the MENU dial to set each menu
item. When you press the MENU dial when the
cursor is on “Set,” the setting display disappears
and the clock setting is completed.
After the initial setup screen disappears, you can
change Time Zone and date/time settings using
Maintenance > Clock Set (page 50) in the full
menu.
[Notes]
ˎˎ If the clock setting is cleared because the backup battery
fully discharged when no power was supplied (no battery
pack and no DC IN connection), the initial setup display
will be displayed when you next turn the unit on.
ˎˎ While the initial setup display is shown, no other
operation, except turning the power off, is permitted until
you finish the setting for this display.
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2. Preparation

Attaching the VF Attachment and Handle
Attaching the VF Attachment

Attaching the Handle

1

1

2

Slide the VF attachment on in the direction of
the arrow to attach it.
Position the VF attachment in the desired
front/rear position, then turn the lock lever to
secure it in position.

2

Slide the handle on in the direction of the
arrow to attach it.
Position the handle in the desired front/rear
position, then turn the lock lever to secure it in
position.
Hex socket
bolt

2

Lock screw

2
1

Lock
lever

1
Lock
lever

[Note]
You can also attach the VF attachment in the front/rear
or left/right orientation.

To remove the VF attachment
Turn the lock lever to loosen, press the release
button and slide the VF attachment off in the
reverse direction from when attaching it.

[Notes]
ˎˎ You can also attach a lock screw using a hex wrench
(5 mm) to secure it in position.
ˎˎ If the lock lever on the handle becomes loose during
use, you can secure the handle by tightening a hex
socket bolt (2 mm) beside the lock screw.
ˎˎ You can also attach the handle in the reverse
orientation.

To remove the handle
Turn the lock lever to loosen, press the release
button and slide the handle off in the reverse
direction from when attaching it.
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2. Preparation

Mounting a Lens and Adjusting the Flange Focal Length
Recommended lens (Super 35mm size)
SCL-PK6/F, SCL-PK6/M (set of 6 lenses, 20 mm/25
mm/35 mm/50 mm/85 mm/135 mm)
SCL-PK3/F, SCL-PK3/M (set of 3 lenses, 20 mm/25
mm/135 mm)
SCL-P11X15

[Note]

Attaching a PL Mount Lens

1

Remove the mount cover from the lens mount
by turning the PL mount lever
counterclockwise.

For details about available lenses for the unit, contact a Sony
service representative.

[CAUTION]
Do not leave the lens facing the sun. Direct
sunlight can enter through the lens, be focused in
the unit, and cause fire.

Do not turn the lens when attaching the PL mount lens.
It may cause damage to the hot shoe pin.

To attach a Cooke /i lens
Align the contacts on the lens with the hot shoe of
the unit. There are two connectors on the side of
the lens adaptor, and either can be used.

To remove the lens
PL mount
lever

1

[Notes]
ˎˎ A lens is a precision part. Do not place the lens down with
the mount side facing down. Attach the cap supplied
with the lens.
ˎˎ The lens interface of the unit is configured by factory
default for an SCL-P11X15 and lenses with Cooke type
connector. To use an SCL-PK6, SCL-PK3, or other lenses
that do not have a Cooke type connector, set Technical
> System Configuration > Lens Interface (page 49)
to Off in the full menu. If this setting is not correct, an
alert message appears when the unit is turned on after
attaching the lens.

2

Turn the PL mount lever counterclockwise
while holding the lens from underneath.
Pull the lens forward.
[Notes]

[Note]
Turn the PL mount lever counterclockwise to the
stopper position.

2
3

Insert the lens into the lens mount by aligning
the concave part of the lens with the
positioning pin on the upper right of the lens
mount.
Secure the lens by turning the PL mount lever
clockwise while holding the lens.

ˎˎ If another lens will not be attached soon, carefully
align the concave part of the mount cover, then
secure the mount cover by turning the PL mount
lever clockwise.
ˎˎ In firmware version 1.0, images will not be output
normally if the PL mount adaptor is removed.

Adjusting the Flange Focal Length
The unit is shipped with the flange focal length
already adjusted. If you need to adjust the flange
focal length, remove the lens mount, and change
the shims with those of the appropriate thickness.
You can adjust the thickness by ±0.1 mm in 0.01
mm increments.

Shims
The following shims are supplied with the unit.
0.05 mm × 1 (circular)
0.01 mm × 15 (1/3 arc)
1/3 arc shims should always be used as a set of
three shims. Insert shims to increase the flange
focal length. The unit is shipped with the flange
focal length already adjusted using the following
three types of shims.
0.10 mm (circular)
0.05 mm (circular)
0.01 mm (1/3 arc)
A seal is attached showing the shim thickness
when shipped.
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2. Preparation: Mounting a Lens and Adjusting the Flange Focal Length

4

Adjusting the flange focal length

1

Remove the six Torx screws and remove the PL
mount flange.

5

PL mount flange

1

Shims

2
3

Loosen the four Phillips screws on both sides
of the PL connectors (two locations), and
remove the PL connectors and PL connector
plates.

When using circular shims
Attach with the surface that has markings on it
facing the front.
Markings

Attach shims to the PL mount adaptor (three
locations).
PL connectors

2
3

3

2

3

PL connector plates
Markings

When using 1/3 arc shims
Attach shims that have the same thickness in
all three locations.

Reattach the PC connectors (two locations) to
their original positions, and tighten the four
Phillips screws with 0.18 N·m tightening
torque.
Reattach the PL mount flange in its original
position, and tighten the six Torx screws to a
tightening torque of 0.35 N·m using a T8
torque wrench.

Cleaning the Filter
To clean the filter, first remove the adaptor.
Exercise care when wiping the adaptor center
part (shaded part) with a cloth or other material
to prevent fibers adhering to surfaces. If fibers are
adhering, wipe off using a soft brush.
Adaptor
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2. Preparation

Attaching a Viewfinder
Available viewfinders for the unit
DVF-EL200: OLED color viewfinder
DVF-L700: LCD color viewfinder

1
Viewfinders are available separately.
This section describes attachment of the DVFEL200 as an example.
For details about attaching each viewfinder, refer to the
operating instructions of the viewfinder.

Clamper

Attaching a Viewfinder

2

[CAUTION]
Do not leave the unit with the eyepiece of the
viewfinder facing the sun. Direct sunlight can
enter through the eyepiece, be focused in the
viewfinder, and cause fire.

Align the viewfinder shoe with the groove of
the viewfinder mount on the VF attachment,
and attach the viewfinder.

Adjusting the Viewfinder Position
To adjust the front/rear position

1

Turn the viewfinder lock lever in the LOCK
direction to secure it in position.

2

2

Loosen one or both of the front/rear rod lock
levers of the VF attachment.
Slide the VF attachment forward/rearward to
adjust the viewfinder position.

Lock lever

[Notes]
ˎˎ Attach/remove the viewfinder while the unit is turned off.
ˎˎ A VF cable (A-2201-632 or A-2201-633-A) is required in
order to attach the DVF-L700. Also, turn the unit on after
setting the POWER switch of the DVF-L700 to the ON
position.

1

2
[Note]

1

Secure the cable in the clamper as required.

To remove the viewfinder

1
2
3

Connect the viewfinder and unit using the VF
connection cable.
Viewfinder side:
Position the connector with the mark (red) at
the top, and fully insert the connector.
Camera side:
Alight the concave part of the VF connector
with the connector mark (red), and fully insert
the connector.

1

Disconnect the VF connection cable from the
viewfinder and unit.
Turn the lock lever in the direction opposite to
LOCK, then remove the viewfinder from the VF
attachment.

Rod lock
levers

3

Tighten the rod lock levers.
[Note]
If a rod lock lever is difficult to turn, pull the lever out,
turn it to a position where it is easier to operate, and
then push the lever back in.
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2. Preparation: Attaching a Viewfinder

To adjust the left/right position and height
(angle)

1
2

To adjust the viewfinder angle
You can adjust the angle of the viewfinder while
shooting.

Loosen the rod lock lever at the front of the VF
attachment.

1

Slide the VF attachment rod left/right and turn
the rod up/down to adjust the viewfinder
position.

2

Loosen the rotation lock lever on the
viewfinder mount.
Turn the viewfinder up/down to adjust the
angle.
Rotation lock lever

2
1
2

2

1
Lock screw
Rod lock lever

3

Tighten the rod lock lever.
[Note]
When the rod lock lever is loosened, adjust the lock
screw using a hex wrench (3 mm) to prevent the
viewfinder from falling down.

3

Tighten the rotation lock lever.
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2. Preparation

Handling SxS Memory Cards
This unit records audio and video on SxS memory
cards (optional) loaded in the card slots.

About SxS Memory Cards
Use the following Sony SxS memory cards or XQD
memory cards.*

ˎˎSxS, SxS PRO, and SxS-1 are trademarks of Sony
Corporation.
ˎˎXQD is a trademark of Sony Corporation.
ˎˎThe ExpressCard word mark and logo are
owned by Personal Computer Memory Card
International Association (PCMCIA) and
are licensed to Sony Corporation. All other
trademarks are the property of their respective
owners.

Inserting an SxS Memory Card

Removing an SxS Memory Card

1

1
2

2

* When using an XQD memory card, the XQD ExpressCard
adaptor (QDA-EX1) is required.

Open the cover of the card slot block
(page 7).
Insert the SxS memory card into the slot with
the SxS label facing to the right.
The ACCESS lamp (page 6) lights in red
then changes to green once the memory card
is ready for use.

The supported memory cards differ depending on
the recording format.

3

SxS PRO+

ACCESS lamp status

SBP-256D, SBP-128B/C/D, SBP-64B/C/D: Supported
for all recording formats.

SxS PRO
SBP-64A, SBP-32:
MPEG 1920×1080P/i

SxS-1
SBS-64G1A/B, SBS-32G1A/B:
MPEG 1920×1080P/i

XQD memory card S series, G series
QD-S64E, QD-S32E, QD-G128A/E, QDG64A/E, QDG32A/E: Supported for all recording formats.

XQD memory card N series, M series
QD-N64, QD-M128A, QD-M64A, QD-M32A:
MPEG 1920×1080P/i
Operations are not guaranteed with other memory
cards.
These memory cards comply with the ExpressCard
standard.
For details on using SxS memory cards and usage-related
precautions, refer to the instruction manual for the SxS memory
card.

Pull out the SxS memory card.

[Note]
Data integrity is not guaranteed if the power is turned off or
a memory card is removed while it is being accessed. Data
on the card may be destroyed. Be sure that its ACCESS lamp
is lit in green or off when you turn off the power or remove a
memory card.

Close the cover.

Card slots A and B each have an ACCESS lamp that
indicate the slot status.
Lamp
Lights in red
Lights in green

Off

Open the cover of the card slot block .

Switching Between SxS Memory
Cards

Slot status
Accessing the SxS memory
card (writing/reading data)
Standby (ready for recording
or playback using the SxS
memory card)

When SxS memory cards are loaded in both slot A
and slot B, you can press the SLOT SELECT button
(page 7) to select the SxS memory card to use.
If a card becomes full, recording continues after
automatically switching to the second card.

ˎˎNo SxS memory card is
loaded.
ˎˎThe loaded card is invalid.
ˎˎAn SxS memory card is
loaded, but the other slot is
selected.

The SLOT SELECT button is disabled while recording/
playback is in progress. The memory cards are not switched
even if you press the button.

[Note]
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2. Preparation: Handling SxS Memory Cards

Formatting (Initializing) SxS Memory
Cards
When an unformatted SxS memory card or an SxS
memory card formatted in another specification
is loaded, a message notifying you that the media
has a different file system appears. In this case,
format the memory card in the following way.

1
2
3

Select TC/Media category > Format Media in
the menu.
Select SxS Slot A (slot A) or SxS Slot B (slot B),
then press the MENU dial.
A confirmation screen prompting whether to
format the card appears.
Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

Formatting while recording
Even while recording, the SxS memory card loaded
in the other card slot can be formatted.

Checking the Remaining Recording
Time
While shooting (recording or standby), you can
check the remaining capacity on the SxS memory
cards loaded in each slot using the recording
media remaining capacity indicator on the Home
screen of the sub display (page 27) or the
viewfinder screen (page 11).
The available time for recording with the current
video format (recording bit rate) is calculated
according to the remaining space on each card
and displayed in time units of minutes.
[Note]
A

icon appears if a memory card is write-protected.

Exchanging an SxS memory card

A write-protected SxS memory card or memory
card that cannot be used with this unit will not be
formatted.
A warning message is displayed. Replace the card
with an appropriate SxS memory card, according
to the instructions in the message.

ˎˎIf the total remaining time on the inserted
memory cards during recording becomes less
than 5 minutes, the remaining media capacity
indicator flashes, the REC lamp flashes, and a
beep sound is emitted to warn you. Replace the
cards with those that have sufficient space.
ˎˎIf you continue recording, the message “Media
Full” appears, and recording stops when the
total remaining recording time falls to 0.

[Note]

[Note]

If formatting fails

All the data, including recorded pictures and setup files, are
erased when a memory card is formatted.

Up to approximately 600 clips can be recorded on one SxS
memory card.
The display of remaining recording time changes to “0”
and the message “Media Full” appears when the clip limit is
reached.

Restoring an SxS Memory Card
If for any reason an error should occur in a memory
card, the card must be restored before use.
If an SxS memory card that needs to be restored is
loaded, a message prompting you to execute the
restore operation is displayed on the sub display.
To start the restore process, select Execute by
turning the MENU dial, then press the MENU dial.
The restoration starts.
During execution, a message is displayed and the
ACCESS lamp lights in red.
When restoration ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If restoration fails
ˎˎA write-protected SxS memory card, or one on
which an error occurred, cannot be restored.
For such a card, a warning message is displayed.
Release the write protection or replace the card,
according to the instructions in the message.
ˎˎAn SxS memory card on which an error occurred
may become usable again when reformatted.
ˎˎIn some cases, some clips can be restored while
others cannot. Playback of the restored clips
becomes possible again.
ˎˎThe following operation may restore an SxS
memory card for which the message “Could not
Restore Some Clips” is repeatedly displayed each
time you try the restoration process.
[1] Copy the required clips to another SxS
memory card.
[2] Format the unusable SxS memory card on
the unit.
[3] Copy the required clips back to the newly
formatted SxS memory card.
[4] Update the management file as described
below.
[Note]
For restoration of media recorded with this unit, be sure to
use this unit.

Media recorded with a device other than this unit or with
another unit of different version (even of the same model)
may not be restored using this unit.

Updating the management file
If clips cannot be played back, updating the
management file on the card may improve the
situation.
Use TC/Media > Update Media (page 45) in the
full menu to update the management file.
If you write an XAVC file that is imported by RAW
Viewer V2.2 or later to the “XDROOT\Clip” directory
of an SxS memory card directly, that file can
become playable by executing Update Media.

000
23

2. Preparation

Handling SD Cards for Saving Configuration Data
You can store the configuration file of the camera
on an SD card (optional). The stored file can be
loaded from the SD card.

Removing an SD Card

[Note]

Press the SD card in slightly, then remove the card.

To use media formatted with this unit in the slots
of other devices

[Notes]

Supported SD Cards
SDHC memory cards* (Speed Class: 4 to 10, nonUHS, Capacity: 2 to 32 GB)
SD memory cards* (File system: FAT 16, Capacity:
up to 2 GB)

ˎˎ Data integrity is not guaranteed if the power is turned off
or a memory card is removed while it is being accessed.
Data on the card may be destroyed. Be sure that its
ACCESS lamp is lit in green or off when you turn off the
power or remove a memory card.
ˎˎ Make sure that the card does not pop out when inserting
or removing it.

* Referred to as “SD cards” in this manual.

Formatting (Initializing) an SD Card
Inserting an SD Card
Insert an SD card into the SD card slot (page 10).
The ACCESS lamp (page 8) lights in red then
changes to green once the memory card is ready
for use.

ACCESS lamp status
Lamp
Lights in red

Slot status
Accessing the SD card
(writing/reading data)

Off

ˎˎNo SD card is loaded.
ˎˎThe loaded card is invalid.

SD cards must be formatted the first time they are
used in the unit.
SD cards for use in the unit should be formatted
using the format function of the unit. It is also
necessary to format an SD memory card if a
caution message is displayed when the card is
loaded.
If an SD card that was formatted in an
unsupported format is loaded in the unit, a file
system mismatch message is displayed.

1

2

Select TC/Media category > Format Media >
SD Card in the menu, then press the MENU
dial.
A confirmation screen prompting whether to
format the card appears.
Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

All data is erased when an SD card is formatted, and the data
cannot be restored.

Make a backup of the media, then format it using
the other device.
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2. Preparation

Using with AXS-R7
You can record video/audio in RAW or X-OCN
to an AXS-R7 AXS (Access Memory Card System)
Recorder (optional) by attaching the recorder to
the unit.

Docking module

AXS-R7

[Note]

Inserting an AXS Memory Card

Removing an AXS Memory Card

1

Open the memory slot cover of the AXS-R7, and
pull out the AXS memory card.

Update the AXS-R7 to version 1.1 before attaching it to
the unit. After updating the version, remove the docking
module from the AXS-R7 and attach the AXS-R7 to the unit.
For details about updating the recorder, refer to the Update
Guide for the AXS-R7.

Press the memory card slot cover open button
to open the cover.

[Note]
Data integrity is not guaranteed if the power is turned off or
an AXS memory card is removed while it is being accessed.
Data on the card may be destroyed. Be sure that its ACCESS
lamp is lit in green or off when you turn off the power or
remove a memory card.

Attaching the AXS-R7

Recording to an AXS Memory Card

[Note]
Attach/remove the AXS-R7 while the unit is turned off.

1

Unscrew the four hex screws (3 mm) on the
rear of the unit, and remove the battery plate.

3

Attach the AXS-R7 to the unit, and tighten the
four hex screws.

Battery
plate

2

Unscrew the four hex screws on the rear of the
AXS-R7, and remove the docking module from
the AXS-R7.

2

AXS-R7

[Note]
The AXS memory card in the AXS-R7 does not switch to
the second card automatically, even if the card becomes
full while recording. To switch cards, use the SLOT SELECT
button on the AXS-R7 during recording standby mode.

To remove the AXS-R7
Unscrew the four hex screws, and remove the
AXS-R7.

Insert the AXS memory card into the card slot
with the label facing as indicated below.

You can select the format for recording to an AXS
memory card using Project category > AXS Rec
Format (page 36) in the menu.

Label

3

Close the cover.
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2. Preparation: Using with AXS-R7

Formatting (Initializing) an AXS
Memory Card

Checking the Remaining Recording
Time

AXS memory cards must be formatted the first
time they are used in the AXS-R7 attached to the
unit.
Use the format function of the unit to format
AXS memory cards for use in the AXS-R7. It is
also necessary to format an AXS memory card if
a caution message is displayed when the unit is
turned on with the AXS recorder attached.
If an AXS memory card that was formatted in a
format not supported by the AXS-R7 is loaded, a
file system mismatch message is displayed.

While shooting (recording or standby), you
can check the remaining capacity on a loaded
AXS memory card using the recording media
remaining capacity indicator on the Home screen
of the sub display (page 27) or the viewfinder
screen (page 11).
The available time for recording with the current
video format (recording bit rate) is calculated
according to the remaining space of each card and
displayed in time units of minutes.

1

A

2
3

Select TC/Media category > Format Media in
the menu, then press the MENU dial.
Select AXS Slot A (slot A) or AXS Slot B (slot B).
A confirmation screen prompting whether to
format the card appears.
Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

[Note]
All data is erased when a memory card is formatted, and the
data cannot be restored.

[Note]

Restoring an AXS Memory Card
If for any reason an error should occur in a memory
card, the card must be restored before use.
If an AXS memory card that needs to be restored
is loaded, a message prompting you to execute
restoration is displayed.
To start the restore process, select Execute by
turning the MENU dial, then press the MENU dial.
The restoration starts.
During execution, a message is displayed and the
ACCESS lamp lights in red.
When restoration ends, a completion message
appears. Press the MENU dial to dismiss the
message.

icon appears if an AXS memory card is write-protected.

If restoration fails
ˎˎA write-protected AXS memory card or one on
which an error occurred cannot be restored. For
such a card, a warning message is displayed.
Release the write protection or replace the card,
according to the instructions in the message.
ˎˎAn AXS memory card on which an error
occurred may become usable again when
reformatted.
ˎˎIn some cases, some clips can be restored while
others cannot. Playback of the restored clips
becomes possible again.
[Note]
For restoration of media recorded with this unit, be sure to
use this unit.
Media recorded with a device other than this unit or with
another unit of different version (even of the same model)
may not be restored using this unit.

Updating the management file
If clips cannot be played back, updating the
management file on the card may improve the
situation.
Use TC/Media > Update Media (page 45) in the
full menu to update the management file.
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3. Camera Operations

Sub Display
The sub display displays the Home screen, clip list screen, playback screen, menu screen, full menu screen, and user functions screen.
You can switch between the screens on the sub display using the buttons on the Assistant side of the unit.

User functions screen
User 1

User 2

User 3

SDI Frame Line

Monitor
Status Info

Monitor
LUT bypass

On

Off

On
STBY

HOME button

00:00:00:00

Off

Auto

Monitor
Highlight Clip Ind

Fan Mode

User 4

User 5

Edit

USER button

EI

Fixed-

MENU button

TCG

24

500

Shutter

SxS / AXS

HOME button

90.0

00:00:00:00 23.98fps 3.8K 16:9
DC IN 15.0V Reel A001 Shot C004

Rec

SxS A 120 min
SxS B 180 min

1.8
ND

XAVC QFHD C480 Sub

SxS: Log

HOME button

3200 +03

SxS A

A001C001_180101CQ

Sub OK

TCR 00:00:00:00

A001C002_180101G7

Sub OK

A001C003_180101HR

Sub OK

A001C004_180101WK

Sub OK

00:00:00:00 23.98fps 3.8K 16:9
x24 DC IN 15.0V FPS 60
002/010 XAVC QFHD C480
SXS A

A001C005_180101S8

Sub OK

A001C002_160328WW

A001C006_180101GF

Sub OK

Project

TC/Media

Imager Mode

Full menu screen
Monitoring

ND

23.98fps

Color Space

Exposure Index

S-Gamut3.Cine/Slog3

AXS Rec Format

Rec Off

SxS Rec Format

XAVC 4K Class300

Sub Rec Format

Rec Off

Info

Project Details >

Shooting

Shutter

4K 17:9

Project Frame Rate

Audio

Shooting

White Balance

Technical
Maintenance

LUT Select
Look

USER button

Dur

Prev

MENU button

Menu screen

F Fwd

23.98fps 4K 4:3 2x

002/010

MENU button

Play/Pause

Dur 00:00:01:56

2018/1/1 11:30

CLIPS button

WB

F Rev

Play

XAVC QFHD C480

1 2

SDI 3/4: Look

Playback screen

Clip list screen

Home screen
FPS

CLIPS button

USER button

1 2

Sub OK

Stop/Clips

CLIPS button

Next
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3. Camera Operations: Sub Display

Status display area

Home Screen
Press the HOME button on the Assistant side to display the Home screen. You can check the status of the
unit and set basic settings for the unit on the Home screen.
FPS

24

FixedTCG

SxS A 120 min
SxS B 180 min

Item name/Setting value/Function display area
ITEM key 3

3200 +03
WB

1. FPS
Displays the video frame rate.

2. Exposure Index
Displays and sets the exposure index (EI).

1

2

3

FPS

EI

Shutter

FixedTCG

24

500

3. Shutter
Displays and sets the shutter speed/shutter
angle of the electronic shutter.

90.0

4. ND Filter

00:00:00:00 23.98fps 3.8K 16:9

Rec

Displays and sets the ND filter position.

DC IN 15.0V Reel A001 Shot C004

SxS A 120 min
SxS B 180 min

1.8
ND

5. LUT

XAVC QFHD C480 Sub
1 2

SDI 3/4: Look
SxS: Log

4

5

ITEM key 4

ITEM key 5

3200 +03
WB

6
ITEM key 6

Displays and sets the monitor LUT.

6. WB (White Balance)
Displays and sets the white balance.

TCG

The areas labeled 1 to 6 correspond to ITEM keys 1 to 6
(page 32). Press an ITEM key to select the corresponding
item. The ITEM keys for functions displayed in orange text
color are enabled. FPS selection using ITEM key 1 is not
supported in firmware version 1.0.

3

4

00:00:00:00 23.98fps 3.8K 16:9

DC IN 15.0V Reel A001 Shot C004
SxS A 120 min
XAVC QFHD C480 Sub
SxS B 180 min
1 2

9

8

1. Time data display
Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 36).
Displays the type of data currently shown in
the time data display, as follows.
TCG: Recorded timecode
TCR: Playback timecode
DUR: Duration

2. Frame rate indicator
Displays the value of the Project category >
Project Frame Rate setting in the menu
(page 36).

3. Imager mode indicator
Displays the Project category > Imager Mode
setting in the menu, and de-squeeze
information.

7

5

6

7. Recording format (codec) indicator
Displays the format of the recording on an AXS
memory card or an SxS memory card
(page 39).

8. Power supply voltage/Remaining battery
capacity indicator
Displays the power supply voltage or
remaining battery capacity.

9. Remaining media capacity indicator
Displays the active media icon, media type, slot
type (A/B), and remaining recording time
(when recording in the current recording
format).
It also displays the clip name during playback.

10. Recording status indicator
Displays the following recording operation
states of the unit.

4. Clip name display
Displays “Reel: Camera ID + Reel Number” and
“ShotNumber”.

5. Audio level meters
Displays the audio recording or playback
levels. The numbers 1 and 2 Indicate channels
1 and 2.

6. Simultaneous recording indicator
[Note]

2

Rec

10

Status
display area
1 2

SxS: Log

13
12
11

3.8K 16:9

XAVC QFHD C480 Sub

SDI 3/4: Look

ND

ITEM key 2

90.0

DC IN 15.0V Reel A001 Shot C004

1.8

ITEM key 1

500

00:00:00:00 23.98fps

Rec

Item name/Setting
value/Function
display area

Shutter

EI

1
Ext
LK

When 1-slot simultaneous recording is
configured for the displayed media, a “Sub”
icon appears on the right of the displayed
main recording format.

Display

Stby

Description
Recording standby

Rec

During recording

11. Thermometer icon
Displayed when a high temperature warning
message is issued.
The description is displayed in the Info
category in the menu.
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12. Warning icon
Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.

13. Ext-LK icon
Displayed when the internal timecode
generator is locked to an external signal input
to the TC IN (timecode input) connector.

000
29

3. Camera Operations

Operations on the Home Screen of the Sub Display
Changing the brightness of the sub display

Basic Operation

1

Press the HOME button.
The Home screen appears.
FPS

EI

24

FixedTCG

500

Shutter

90.0

00:00:00:00 23.98fps

REC

4K 4:3 2x SV
DC IN 15.0V Reel A001 Shot C004

SxS A 120 min
SxS B 180 min

1.8
ND

XAVC QFHD C480 Sub
1 2

SDI 3/4: Look
SxS: Log

3200 +03
WB

You can change the brightness of the sub display
using Technical > Control Display > Brightness
level (page 50) in the full menu.
On the Home screen, you can also press and hold
the BACK button and turn the MENU dial clockwise
to change the brightness of the sub display in the
sequence Minimum  Low  Mid  High with
the current setting as the base point.
You can also press and hold the BACK button and
turn the MENU dial counterclockwise to change
the brightness of the sub display in the sequence
High  Mid  Low  Minimum with the
current setting as the base point.

Step Edit Operation

When setting White Balance

You can change the settings available for selection
when “Step Edit” is displayed for ITEM key 4 in step
2 in the basic operation. You can add and delete
settings on the settings edit screen.

On the White Balance settings edit screen, you
can press the Coarse/Fine button (ITEM key 1) to
change the 1-step increment variation to coarse
or fine. You can also press the Temp/Tint button
(ITEM key 3) to switch the value between color
temperature (Temp) and color tone (Tint).

1

+

[Note]

2

Select the item to set using the ITEM keys 1 to
6.
The setting value for items that can be
changed are displayed in orange.
The following diagram shows an example
when ITEM key 3 is pressed.
Set

Step / Cont.
Current:
144.0
(1/59.95 sec)

Step Edit

3
4

22.5
45.0
90.0
144.0
172.8

The display brightness setting is common to both the sub
display and the mini display, and is reflected on both displays
simultaneously.

2

Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

-

Use buttons or
dial to select.

Cancel

To delete a setting, press the Delete button
(ITEM key 4).
[Note]
The selected setting can be deleted if the “Delete”
character string is displayed in orange.

dial to select.

Move the cursor to the item or setting value to
select using the
button (ITEM key 2),
button (ITEM key 5), or MENU dial.

Delete

3
4

+

Step Edit
User Preset

3200 K + 03

90.0

Add

Coarse / Fine

Temp / Tint

Use buttons

3200K +03

or dial to
select temp.

Base:

Step Edit

Use buttons or

Cancel

On the settings selection screen, move the
cursor to the setting you want to change or
delete, and press the Step Edit button (ITEM
key 4).
The settings edit screen appears.

Press the
button (ITEM key 2),
button
(ITEM key 5), or MENU dial to change a setting.
When finished, press the Add button (ITEM key
4).
The setting is added and the display returns to
the setting selection screen.
[Note]
A setting can be added if the “Add” character string is
displayed in orange.

Add Delete

-

Cancel
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Changing Preset Look

LUT Operation
Setting a LUT
You can set a LUT for each output system using
ITEM key 5 on the Home screen.

1

1

Press ITEM key 5 on the Home screen.
The LUT selection screen appears.
Page 1 / 2

SDI 1/2

Outputs

Log

Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.
File Info
Category
Preset Look

SDI 3/4

ACS CDL

Look Info

Home Screen Items on the Sub Display

You can set a LUT when Look is selected on the
LUT selection screen using the Edit Look button
(ITEM key 4) on page 1 or page 2.

s709

Process
ACS CDL File

Load File

The names of items and corresponding setting values are given below.
Default values are shown underlined and in bold text.
Item
FPS

Select
Preset look

Project Frame Rate

s709
Active
1D-3D-CDL
03: Scene4_Dark_160830

Done

Look
Edit Look

Monitor

HDMI

The LUT selection screen has two pages, and
you can switch the page by pressing ITEM key 1.
On page 1, you can set the LUT settings for SDI
1/2 (display only), SDI 3/4, Monitor, and HDMI.
On page 2, you can set the LUT settings for the
viewfinder, SxS Rec, and Sub Rec.

2
3
4

Select the output to set using ITEM keys 2, 3, 5,
and 6.
The settings edit screen appears.
Press the
button (ITEM key 2),
button
(ITEM key 5), or MENU dial to change a setting.
Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

2
3
4

Description
Displays the video frame rate. The setting is determined by the Project category >
Project Frame Rate setting (page 36) in the menu.

Press the Select button (ITEM key 3).
The items that can be selected are displayed.

Exposure Index

Press the
button (ITEM key 2),
button
(ITEM key 5), or MENU dial to change a setting.

Shutter

Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

23.98

Display
Fixed-24

24
25
29.97
50
59.94

Fixed-24
Fixed-25
Fixed-30
Fixed-50
Fixed-60

Sets the EI value. The following settings are available.
125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/
1250EI/1600EI/2000EI
Sets the electronic shutter angle/shutter speed.
Press the Step/Cont. button (ITEM key 1) to switch between step and continuous
selection methods.
Step: Select from up to 16 preset values registered as shutter steps. You can press
the Step Edit button (ITEM key 4) to change any setting from the preset value
after selection.
Displays the following selection options depending on the Technical >
System Configuration > Shutter Mode (page 49) setting in the full menu.
Angle: Shutter angle indicator
Default selection options
360/180/172.8/144/90/45/22.5/11.2/5.6
Speed: Shutter speed indicator
Default selection options
1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 1)
[Note]
The default speed values for different Project Frame Rate (page 36) settings are
given below.
23.98/24: 1/24, 25: 1/25, 29.97: 1/30, 50: 1/50, 59.94: 1/60

Cont.: Select an angle/speed within the supported range.
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Item
ND Filter
LUT

Description
Sets the ND filter position. The following settings are available.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4
Configures settings related to the LUT to apply to the output video.
Page 1
SDI 1/2 (ITEM key 2): Log
Display only, as LUT cannot be applied to the SDI 1/2 output image.
SDI 3/4 (ITEM key 3): Log/Look
Selects the LUT to apply to the SDI 3/4 output image.
Disabled when Monitoring category > Output Format > SDI 1/2 is set to
4K/QFHD in the menu.
Monitor (ITEM key 5): Log/s709/R709(800%)
Selection becomes Log/Look when Monitoring category > Output Format >
SDI 1/2 is set to 4K/QFHD in the menu.
HDMI (ITEM key 6): Log/s709/R709(800%)
Fixed to Log when Monitoring category > Output Format > SDI 1/2 is set to
4K/QFHD and HDMI is set to 4K/QFHD in the menu. In all other cases, the
options are the same as for Monitor.
Page 2

WB (White Balance)

1)

Viewfinder (ITEM key 2): Log/s709/R709(800%)
Selects the LUT to apply to the viewfinder output image.
SxS Rec (ITEM key 5): Log/Look
Disabled when Project category > SxS Rec Format is set to Rec Off in the
menu, or fixed to Log when set to XAVC.
Sub Rec (ITEM key 6): Log/Look
Disabled when Project category > SxS Rec Format is set to Rec Off in the
menu.
Page 1/2 common items
Edit Look: Sets a LUT to apply as a Look.
s709/R709(800%)
Sets the color temperature/color tone of the white balance.
Default selection options
3200K+00/4300K+00/5500K+00
You can press the Step Edit button (ITEM key 4) to change the white balance
preset value and Tint value.

The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0,
1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
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User Functions Screen
You can press the USER button (page 8) to
display the user functions screen on the sub
display and use the ITEM keys 1 to 5 as assignable
buttons (User 1 to 5).
There are also four assignable buttons (pages
6, 7, 8) to which you can assign various
functions.
Functions can be assigned to these buttons using
the user functions screen, in addition to using
Project > Assignable Button in the full menu.
ITEM key 1

ITEM key 2

The user functions selection screen is displayed by
pressing the Edit button (ITEM key 6) on the user
functions screen. You can set the functions for the
User 1 to 5 buttons and assignable buttons 1 to 4
on the user functions selection screen.

ITEM key 3

User 1

User 2

User 3

Monitor
Status Info

Monitor
LUT bypass

On

On

Off

STBY

00:00:00:00

Off

Auto

Monitor
Highlight Clip Ind

Fan Mode

User 4

User 5

ITEM key 4

ITEM key 5

VF Highlight Clip Ind

Monitor Status Info

User 4

Monitor Highlight Clip Ind

ITEM key 5

Select

Monitor LUT bypass

Fan Mode
VF Highlight Clip Ind

SDI Frame Line

Not Assigned

Assignable Button
setting
Not Assigned
SDI Frame Line
SDI Status Info

SDI Frame Line
SDI Status Info

SDI LUT bypass

SDI LUT bypass
Monitor Frame Line
Monitor Status Info

3

Fan Mode

Functions that can be Assigned to ITEM Keys 1 to 5
On the user functions selection screen, move
the cursor to the button you want to change,
and press the Select button (ITEM key 3).
The functions that can be selected are
displayed.

<User 1>

2

Not Assigned
Not Assigned
Not Assigned
Not Assigned
Not Assigned
Not Assigned
Monitor Highlight Clip Ind

Done

Set

ITEM key 6

Assignable Button setting

Displays clipped highlight areas in red in the
viewfinder.
No assignment
No assignment
No assignment
No assignment
No assignment
No assignment
Displays clipped highlight areas in red on the
Monitor output.
Sets the fan control mode.

SDI Frame Line

Assign Btn 1

Edit

Function

Assignable 1

User 1
User 2

User 5

1

Button

Assignable 2
Assignable 3
Assignable 4
ITEM key 1
ITEM key 2
ITEM key 3
ITEM key 4

User 3

SDI Frame Line

The following tables lists the functions that are assigned when the unit is shipped from the factory.

Changing Button Functions

Cancel

Press the
button (ITEM key 2),
button
(ITEM key 5), or MENU dial to change a setting.
When finished, press the Set button (ITEM key
3).
The display returns to the user functions
screen, and displays the changed function.

Monitor Highlight Clip
Ind
Monitor Frame Line
Monitor Status Info
Monitor LUT bypass

Color Bars
AXS Slot Change

Function

State when unit is powered on

No assignment
Turns superimposition of frame lines on the SDI
3/4 output image on/off.
Turns display of information on the SDI 3/4 output
image on/off.
Disables the LUT applied to the SDI 3/4 output
image while the key is pressed, and sets Log
image quality without applying a LUT.
Turns the function that displays clipped highlight
areas in red on the Monitor output image on/off.
Turns superimposition of frame lines on the
Monitor output image on/off.
Turns display of information on the Monitor
output image on/off.
Disables the LUT applied to the Monitor output
image while the button is pressed, and sets Log
image quality without applying a LUT.
Turns color bars on/off.
Switches the active slot when two AXS memory
cards are inserted.
Switches between A and B each time the key is
pressed.

–
Setting retained
Setting retained
Setting not retained

Setting retained
Setting retained
Setting retained
Setting not retained

Setting retained
Setting retained
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Assignable Button
setting
SxS Slot Change

Fan Mode

Format Media AXS
Slot A
Format Media AXS
Slot B
Format Media SxS
Slot A
Format Media SxS
Slot B
APR
Lens Interface

VF Highlight Clip Ind

Function

State when unit is powered on

Switches the active slot when two SxS memory
cards are inserted.
Switches between A and B each time the key is
pressed.
Sets the fan control mode.
Switches between Auto  Max  Off in Rec/
Auto  Off in Rec/Max each time the key is
pressed.
Formats media in AXS slot A.

Setting retained

–

Formats media in AXS slot B.

–

Formats media in SxS slot A.

–

Formats media in SxS slot B.

–

Executes APR.
Selects the lens interface.
Switches between Off  Type C each time the
key is pressed.
Turns the function to display clipped highlight
areas in red in the viewfinder on/off.

–
Setting retained

Setting retained

Functions that can be Assigned to Assignable Buttons 1 to 4
Assignable Button setting
Not Assigned
SDI Frame Line
SDI Status Info

Setting retained

SDI LUT bypass

Monitor Frame Line
Monitor Status Info
Monitor LUT bypass

Monitor Highlight Clip Ind

Color Bars
AXS Slot Change

SxS Slot Change

Rec Review
VF Frame Line

VF Zebra
VF Status Info

Function
No assignment
Turns superimposition of frame lines
on the SDI 3/4 output image on/off.
Turns display of information on the
SDI 3/4 output image on/off.
Disables the LUT applied to the SDI
3/4 output image while the button is
pressed, and sets Log image quality
without applying a LUT.
Turns superimposition of frame lines
on the Monitor output image on/off.
Turns display of information on the
Monitor output image on/off.
Disables the LUT applied to the
Monitor output image while the
button is pressed, and sets Log
image quality without applying a
LUT.
Turns the function that displays
clipped highlight areas in red on the
Monitor output image on/off.
Turns color bars on/off.
Switches the active slot when two
AXS memory cards are inserted.
Switches between A and B each time
the button is pressed.
Switches the active slot when two
SxS memory cards are inserted.
Switches between A and B each time
the button is pressed.
Executes the Rec Review function.
Turns superimposition of frame lines
on the viewfinder output image on/
off.
Turns the zebra function of the
viewfinder output image on/off.
Turns the information display on the
viewfinder output image on/off.

State when unit is powered on
–
Setting retained
Setting retained
Setting not retained

Setting retained
Setting retained
Setting not retained

Setting retained

Setting retained
–

–

Setting not retained
Setting retained

Setting retained
Setting retained
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Assignable Button setting
VF Focus Magnifier
VF LUT bypass

VF Highlight Clip Ind

Function
Turns the focus magnifier function of
the viewfinder on/off.
Disables the LUT applied to the
viewfinder output image while the
button is pressed, and sets Log
image quality without applying a
LUT.
Turns the function to display clipped
highlight areas in red in the
viewfinder on/off.

State when unit is powered on
Setting not retained
Setting not retained

Setting retained
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Menu Operations
By pressing the MENU button while shooting
(during recording or recording standby) or during
playback, you can display and operate the menu
screen on the sub display.
ˎˎProject category: Basic settings and recording
format settings
ˎˎTC/Media category: Timecode value and TC
format settings
ˎˎMonitoring category: SDI/HDMI/Monitor
external signal output format, OSD, and marker
overlay status settings
ˎˎAudio category: Audio source and audio level
settings
ˎˎInfo category: Camera, media, and battery status
information

Basic Operation

5

1

6

2
3

Press the MENU button.
The menu screen appears.
Select the category to set using ITEM keys 1 to
6.
Turn the MENU dial to move the cursor to the
setting item to select.
For each setting item, the setting value is
displayed.
“Menu Item List” (page 36)
Project

TC/Media

Monitoring

Imager Mode

Controls

4K 17:9

Project Frame Rate

23.98
S-Gamut3.Cine/Slog3

Input Color Space

MENU button (page 7)

AXS Rec Format

Rec Off

SxS Rec Format

XAVC 4K Class300
Rec Off

Sub Rec Format

Press to display the menu on the sub display.

Audio

Info

Project Details >

ITEM keys 1 to 6 (page 7)
Selects the category of the menu.

SEL/SET dial (MENU dial) (page 7)
Turn to move the cursor in the corresponding
direction to select setting items or setting values.
Press the MENU dial to apply the selected item.

BACK button (page 8)
Press to return to the previous menu. Unconfirmed
changes are canceled.

4

Press the MENU dial.
The setting value selection screen appears
next to the selected item.
Project

TC/Media

Monitoring

Imager Mode

4K 4:3

Project Frame Rate

4K 17:9

Input Color Space

3.8K 16:9

AXS Rec Format

Rec Off

SxS Rec Format

XAVC 4K Class300
Rec Off

Sub Rec Format

Audio

Info

Project Details >

Turn the MENU dial to move the cursor to the
setting value.
Press the MENU dial to apply the setting.
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TC/Media category

Menu Item List

Default values are shown underlined and in bold text.
The items available in each category are given below.

Project category

Item
TC Mode

Settings
Preset F-Run (Ext-Lk)/
Preset R-Run/Int Regen

TC Display

Timecode/Duration

Default values are shown underlined and in bold text.
Item
Imager Mode

Settings
Description
6K 3:2/4K 4:3/4K 17:9/3.8K 16:9 Sets the effective picture size.
[Notes]
ˎˎ “6K 3:2” and “4K 4:3” are displayed only when a
license is installed.
ˎˎ Clips recorded in 6K 3:2 cannot be played back on
the unit.

Project Frame Rate

23.98/24/25/29.97/50/59.94

Sets the project frame rate.

Input Color Space

S-Gamut3.Cine/Slog3

AXS Rec Format 1)
(Only when an AXS-R7 is
attached)
SxS Rec Format 1)

Rec Off/RAW SQ/X-OCN
ST/X-OCN LT

Sets the color space. Fixed to S-Gamut3.Cine/
Slog3 in firmware version 1.0.
Sets the recording format for AXS memory cards
when an AXS-R7 is connected.

Sub Rec Format 1)
Project Details
(ITEM key 6)
1)

Rec Off/XAVC 4K Class480/
XAVC 4K Class300/XAVC
QFHD Class480/XAVC QFHD
Class300/MPEG HD P/
MPEG HD i
Rec Off/MPEG HD P/
MPEG HD i

Sets the main recording format for SxS memory
cards.

Sets the sub recording format for SxS memory
cards.
Displays the contents of the Project menu
(page 43) in the full menu.

The recording formats available vary depending on the combination of the effective picture size and project frame rate
settings. For details about settings, see “Recording Format Settings” (page 39).

Setting
TC Setting
(set when switching (H, M, S, F)
to another screen)
Reset

Description
Sets the timecode mode.
Preset F-Run (Ext-Lk): Timecode
advances continuously from specified
value, regardless of whether recording or
not.
Preset R-Run: Timecode advances from
specified value only when recording.
Int Regen: Timecode continues from that
of the previous clip.
Switches the time data indication.
Sets the timecode to a desired value.
Resets the timecode to 00:00:00:00.

TC Format

DF/NDF

TC Source

Internal/External

Cam ID

A to Z

Reel#

001 to 999

Camera Position

C/L/R

Sets the timecode format.
DF: Drop frame
NDF: Non drop frame
Display only.
Sets the camera ID used when
generating clip names.
Clip name: Camera ID + Reel Number +
Shot Number + date + random string
Sets the numeric portion of the Reel
Number used when generating clip
names.
Clip name: Camera ID + Reel Number +
Shot Number + date + random string
Sets the first character portion of the
Shot Number used when generating clip
names.
Clip name: Camera ID + Reel Number +
Shot Number + date + random string
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Item
AXS Slot A
Format Media
(executed when
AXS Slot B
switching to another
SxS Slot A
screen)
SxS Slot B

Settings

Description
Formats the AXS memory card in slot A.

Item
SDI 3/4

Formats the AXS memory card in slot B.

[Note]

Formats the SxS memory card in slot A.
Formats the SxS memory card in slot B.

SD Card

Formats the SD card.

Media Details
(ITEM key 6)

Displays the contents of the TC/Media
menu (page 44) in the full menu.

Depending on the
Output Format setting
of SDI 1/2, the Output
Format, Info, Frame
Line settings of SDI
3/4 may be blank and
cannot be changed.

Monitor

Monitoring category
Default values are shown underlined and in bold text.
[Notes]
ˎˎ The unit supports independent configuration of Info and Frame Line for each system. The display information for the A and
B output images is configured using the Monitoring menu (page 45).
ˎˎ Info and Frame Line may not be displayed depending on the Output Format setting. In this case, “–” is displayed and the
setting cannot be changed.

Item
VF

SDI 1/2

Info

Settings
A/B/Off

Frame Line

A/B/Off

Output
Format

The available settings vary
according to the imager
mode, project frame rate, and
SxS recording format settings.
–
Information display is not superimposed
on the SDI 1/2 output.
A/B/Off
Selects the frame lines to display
superimposed on the SDI 1/2 output.

Info
Frame Line

Description
Selects the information to display
superimposed on the viewfinder image.
Selects the frame lines to display
superimposed on the viewfinder image.
Selects the SDI 1/2 output format. 1)

[Note]
Frame lines are only superimposed if the
output format is 4K/QFHD.

HDMI

Moni. Details
(ITEM key 6)
1)
2)

Info

Settings
The available settings vary
depending on the SDI 1/2
setting.
A/B/Off

Frame Line

A/B/Off

Output
Format
Info

The available settings vary
depending on the SDI 1/2
setting.
A/B/Off

Frame Line

A/B/Off

Output
Format

The available settings vary
depending on the SDI 1/2
setting.

Output
Format

Description
Selects the SDI 3/4 output format. 1)

Selects the information to display
superimposed on the SDI 3/4 output.
Selects the frame lines to display
superimposed on the SDI 3/4 output.
Selects the Monitor output format. 2)

Selects the information to display
superimposed on the Monitor output.
Selects the frame lines to display
superimposed on the Monitor output.
Selects the HDMI output format. 2)

Displays the contents of the Monitoring
menu (page 45) in the full menu.

For details about formats available for selection, see “SDI OUT Connector Output Formats” (page 64).
For details about formats available for selection, see “MONITOR OUT Connector/HDMI OUT Connector Output Formats”
(page 66).
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Audio category

Checking the Status using the Info Category

Default values are shown underlined and in bold text.
Item
Source Switch

Settings
LINE / AES/EBU / MIC

CH-1 Audio Level

Auto/Manual
–99 to ±0 to +99

CH-2 Audio Level

Auto/Manual
–99 to ±0 to +99

MIC Reference

–60dB/–50dB/–40dB

Monitor CH

Monitor Level

When Monitor Output CH Pair
is set to CH-1/CH-2
CH-1/CH-2, CH-1, CH-2
When Monitor Output CH Pair
is set to CH-3/CH-4
CH-3/CH-4, CH-3, CH-4
0 to 99

CH1 Level Meter

–

Description
Displays the position of the AUDIO IN switch
(page 7) that sets the CH1 and CH2 input
source.
The audio recording level is adjusted
automatically when set to Auto.
The audio recording level is adjusted manually
when set to Manual.
The audio recording level is adjusted
automatically when set to Auto.
The audio recording level is adjusted manually
when set to Manual.
Selects the reference input level of the
microphone.
Selects the audio channel that is output to the
headphones and speaker.

Adjusts the monitor audio level.

No.
1

Page
Camera Condition

2

Firmware

3

System

CH2 Level Meter

–

Displays the CH2 level meter.

–

Displays the CH3 level meter.

CH4 Level Meter

–

Displays the CH4 level meter.

Description
Displays warning messages and error messages. When there are
no messages, “All Systems are OK” is displayed at the top of the
display area.
Displays the firmware version of the unit, the serial number and
firmware version of the AXS-R7 attached to the unit, and the
name and validity of option software licenses on the unit. If an
option is not added or currently valid, “Not Installed” or “Expired”
is displayed.
Displays the following system information.
ˎˎDate and time
ˎˎFan rotation speed
ˎˎSensor detection temperature
ˎˎHours meter
ˎˎIP Address

4

Battery

Displays the following battery information.
ˎˎDetected battery name or type
ˎˎRemaining capacity (%)
ˎˎEstimated remaining time
ˎˎRemaining capacity (Ah)
ˎˎVoltage (V)
ˎˎNumber of times that the battery has been charged
ˎˎPower source
ˎˎSupplied power source voltage

Displays the CH1 level meter.

CH3 Level Meter
Audio Details
(ITEM key 6)

You can check the status of media and the battery, and check the contents of warnings and errors that
are issued using the Info category. The contents of the display update in realtime as the status of the unit
changes.
The Info category consists of the following six information pages. Turn the MENU dial to switch the page.

Displays the contents of the Audio menu
(page 48) in the full menu.
5

Media

6

Lens

Displays the remaining capacity, remaining recording time, and
lifespan data of SxS memory cards, AXS memory cards (when
AXS-R7 is attached), and SD cards.
Displays the following information for the lens attached to the
unit.
ˎˎLens model name
ˎˎT value of iris
ˎˎFocal length
ˎˎFocus distance
ˎˎDepth of field
ˎˎSerial number
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Recording Format Settings

Project Frame Rate

The following recording formats can be selected for different combinations of effective picture size and
project frame rate settings.
If a value shown underlined and in bold text is selected, a LUT setting can be applied to the recorded
video signal.

24

Project Frame Rate

23.98

Effective picture
size (Imager Mode)

Main recording format
AXS Rec Format

SxS Rec Format

4K 17:9
(4096×2160)

Off

Off
4K XAVC-I Class480
4K XAVC-I Class300

RAW/X-OCN
ST/X-OCN LT
3.8K 16:9
(3840×2160)

Off

Off
MPEG HD422 1)
Off
QFHD XAVC-I
Class480
QFHD XAVC-I
Class300

4K 4:3
Anamorphic
(4096×3024)
6K 3:2 (6048×4032)

MPEG HD422
RAW/X-OCN
Off
ST/X-OCN LT
MPEG HD422
Off
Off
X-OCN ST/X-OCN LT Off
MPEG HD422 1)
Off

Off

X-OCN ST/X-OCN LT Off

Off

Off

Main recording format
AXS Rec Format

SxS Rec Format

SxS sub recording
format (Sub Rec
Format)

4K 17:9
(4096×2160)

Off

Off
4K XAVC-I Class480
4K XAVC-I Class300
Off

–
Off
Off
–

Off
Off

Off
–

4K 4:3
Anamorphic
(4096×3024)
6K 3:2 (6048×4032)

RAW/X-OCN
ST/X-OCN LT
Off
RAW/X-OCN
ST/X-OCN LT
Off
X-OCN ST/X-OCN LT

Off
Off

Off
–

Off

Off

4K 17:9
(4096×2160)

X-OCN ST/X-OCN LT Off
Off
Off
4K XAVC-I Class480

3.8K 16:9
(3840×2160)

SxS sub recording
format (Sub Rec
Format)
–
Off
MPEG HD422 1)
Off
MPEG HD422 1)
–
–
Off
Off
MPEG HD422
Off
MPEG HD422
–
–
–
Off
–
–

Effective picture
size (Imager Mode)

25/29.97

4K XAVC-I Class300
RAW/X-OCN
ST/X-OCN LT
3.8K 16:9
(3840×2160)

Off

Off
MPEG HD422 1)
Off
QFHD XAVC-I
Class480
QFHD XAVC-I
Class300

RAW/X-OCN
ST/X-OCN LT

MPEG HD422
Off
MPEG HD422

Off
Off
–
Off
MPEG HD422 1)
Off
MPEG HD422 1)
–
–
Off
Off
MPEG HD422
Off
MPEG HD422
–
–
–
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Project Frame Rate

50/59.94

Effective picture
size (Imager Mode)

Main recording format
AXS Rec Format

SxS Rec Format

4K 17:9
(4096×2160)

Off

Off
4K XAVC-I Class300

RAW/X-OCN
ST/X-OCN LT

Off
MPEG HD422 1)
Off
QFHD XAVC-I
Class300

3.8K 16:9
(3840×2160)

Off

RAW/X-OCN
ST/X-OCN LT
1)

Horizontal frame with black bars across top and bottom (letterboxing).

MPEG HD422
Off
MPEG HD422

SxS sub recording
format (Sub Rec
Format)
–
Off
MPEG HD422 1)
–
–
Off
Off
MPEG HD422
–
–
–
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Full Menu Operations
The full menu for configuring the required settings
for shooting and playback is displayed on the sub
display be pressing and holding the MENU button
for 2 seconds or longer.

Controls
MENU button (page 7)

Menu Structure

Press and hold for 2 seconds or longer to display
the full menu on the sub display.

SEL/SET dial (MENU dial) (page 7)

Shooting menu

Turn to move the cursor in the corresponding
direction to select setting items or setting values.
Press the MENU dial to apply the selected item.

Menu used to make settings related to shooting.

Project menu
Menu used to make basic settings for a project.

TC/Media menu
Menu used to make settings related to timecode
and recording media.

Monitoring menu
Menu used to make settings related to video
output and viewfinder output.

Audio menu
Menu used to make settings related to audio.

Technical menu
Menu used to make settings related to technical
matters.

Maintenance menu
Menu used to make unit settings, such as the clock
and language settings.

BACK button (page 8)
Press to return to the previous menu. Unconfirmed
changes are canceled.

Setting Menu Items
Turn the MENU dial to move the cursor to the
menu item you want to set, then press the MENU
dial to select that item.
ˎˎThe menu item selection area can show a
maximum of nine lines. When all the selectable
items cannot be displayed at one time, you can
scroll the display up or down by moving the
cursor.
ˎˎFor items having a wide range of available
values (example: –99 to +99), the selection
area is not displayed. The current setting is
highlighted to indicate that the value can be
changed.
ˎˎIf you select Execute for an executable item, the
corresponding function is executed.
ˎˎWhen you select an item that you must confirm
before execution, a confirmation message
appears. Follow the instructions in the message
to execute or cancel the operation.
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Full Menu List
The functions and available settings of each menu item are given below.

Shooting Menu
Default values are shown underlined and in bold text.
Shooting > Shutter
Makes settings related to the electronic shutter.
Menu item
Settings
Shutter Select
When Shutter Mode (page 49)
is set to Speed
Default selection options
1/24, 1/25, 1/30, 1/50, 1/60,
1/100, 1/120, 1/250, 1/500,
1/1000, 1/2000 1)
When Shutter Mode (page 49)
is set to Angle
Default selection options
360.0/180.0/172.8/144.0/
90.0/45.0/22.5/11.2/5.6
When Step/Cont. Select is set to
Continuous, the selection range
is 360.0 to 4.2 (Angle) or 1/241) to
1/80002) (Speed).
Step/Cont. Select
Step/Continuous
Add/Change Step

Delete Step
Shooting > ND
Sets the ND filter position.
Menu item
Settings
ND Position
Clear/0.3/0.6/0.9/1.2/1.5/1.8/
2.1/2.4

Shooting > White Balance
Makes settings related to white balance.
Menu item
Settings
Color Temp. Select
3200K+00/4300K+00/
5500K+00
+ other added options (up to 16)
Add/Change Step
Delete Step

Description
Selects shutter angle or speed of the electronic
shutter.
The default speed values for different Project
Frame Rate (page 43) settings are given below.
23.98/24: 1/24
25: 1/25
29.97: 1/30
50: 1/50
59.94: 1/60

Selects whether the electronic shutter values are
step values or continuous.
Adds or edits a selection option available in
Shutter Select in Step mode.
Up to 16 selection options can be added.
Deletes a selection option available in Shutter
Select in Step mode.

Description
Selects the density of the ND filter.

Shooting > Exposure Index
Sets the EI value.
Menu item
Settings
Description
Selects the EI value.
EI Select
125EI/160EI/200EI/250EI/320EI/
400EI/500EI/640EI/800EI/1000EI/
1250EI/1600EI/2000E

Description
Displays and selects the color temperature/color
tone of the white balance.
Adds or edits a selection option by changing the
color temperature and tint value of white balance.
Deletes an added selection option.

Shooting > LUT Select
Makes settings related to the LUT to apply to the output image.
Menu item
Settings
Description
SDI 1/2
Log
Display only, as LUT cannot be applied to the SDI
1/2 output image.
SDI 3/4
Log/Look/--Selects the LUT to apply to the SDI 3/4 output
image.
Selects the LUT to apply to the Monitor output
Monitor
Log/s709/R709(800%)/Look/--image.
The default values are given
below.
When Output Format >
SDI 1/2 is 2K/HD: s709
When Output Format >
SDI 1/2 is 4K/QFHD: Look
Displays the LUT to apply to HDMI output image.
HDMI
Log/s709/R709(800%)/Look
The default values are given
below.
When Output Format >
SDI 1/2 is 2K/HD: s709
When Output Format >
SDI 1/2 is 4K/QFHD and
HDMI is not 4K/QFHD: Look
When Output Format >
HDMI is 4K/QFHD: Log
VF LUT

Log/s709/R709(800%)

SxS Rec

Log/Look/---

Sub Rec

Log/Look/---

Selects the LUT to apply to the viewfinder output
image.
Selects the LUT to apply to SDI Main clip recorded
video.
Selects the LUT to apply to SDI Sub clip recorded
video.
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Shooting > Look
Makes settings related to Preset Look.
Menu item
Category
Preset Look Select

1)

2)

Settings
Preset Look
s709/R709(800%)

Project Menu
Description
Displays the LUT category.
Selects the Preset Look.
Outputs images that are suitable as the starting
point for color grading or images that are close to
print film quality.
s709: Cinema color
R709(800%): Faithful color

The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0,
1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
The options are 1/7000 and preceding values when the project frame rate is 50.0 or 25.0, and 1/6000 and preceding values
when 24.0 or 23.98.

Default values are shown underlined and in bold text.
Project > Basic Setting
Makes settings related to picture size and project frame rate.
Menu item
Settings
Description
Imager Mode
6K 3:2/4K 4:3/4K 17:9/3.8K 16:9
Selects the effective picture size.
[Notes]
ˎˎ “6K 3:2” and “4K 4:3” are displayed only when a license
is installed.
ˎˎ Clips recorded in 6K 3:2 cannot be played back on
the unit.

Project Frame Rate
AXS Rec Format
(Only when an AXS-R7
is attached)
SxS Rec Format

Sub Rec Format
SxS/Output
De-Squeeze

23.98/24/25/29.97/50/59.94
Rec Off/RAW SQ/X-OCN ST/
X-OCN LT

Selects the project frame rate.
Selects the video format for recording onto an
AXS memory card inserted into an AXS-R7.

Rec Off/XAVC 4K Class480/
XAVC 4K Class300/XAVC QFHD
Class480/XAVC QFHD Class300/
MPEG HD P/MPEG HD i
Rec Off/MPEG HD P/MPEG HD i

Selects the video format to be recorded on an SxS
memory card.

×2.0

Selects the sub recording format for SxS memory
cards.
Displays the de-squeeze process status for SxS
recording signals and video output signals.
Displayed only when Imager Mode is set to 4K 4:3.

Project > Assignable Button
Assigns functions to assignable buttons.
For details about assigning functions, see “User Functions Screen” (page 32).

Menu item
<1>
<2>
<3>
<4>
<User 1>
<User 2>
<User 3>
<User 4>
<User 5>

Settings
page 32
page 32
page 32
page 32
page 32
page 32
page 32
page 32
page 32

Description
Assigns a function to assignable button 1.
Assigns a function to assignable button 2.
Assigns a function to assignable button 3.
Assigns a function to assignable button 4.
Assigns a function to ITEM key 1.
Assigns a function to ITEM key 2.
Assigns a function to ITEM key 3.
Assigns a function to ITEM key 4.
Assigns a function to ITEM key 5.
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Project > All File
Makes settings related to All-settings files.
Menu item
Settings
Load SD Card
Save SD Card
File ID
Format SD Card

TC/Media Menu
Description
Load an All-settings file from an SD card.
Save an All-settings file on an SD card.
Displays the file ID of the All-settings file for
editing.
Formats an SD card.

Default values are shown underlined and in bold text.
TC/Media > Timecode
Makes settings related to timecode.
Menu item
Settings
Mode
Preset F-Run (Ext-Lk)/
Preset R-Run/Int Regen

Manual Setting
Reset

00:00:00:00 to 23:59:59:29
Execute/Cancel

TC Format

DF/NDF

TC Source
Time Data Display

Internal/External
Timecode/Duration

Description
Selects the timecode mode.
Preset F-Run (Ext-Lk): Timecode advances
continuously from specified value, in sync
with external input timecode.
Preset R-Run: Timecode advances from specified
value only when recording.
Int Regen: Timecode continues from that of the
previous clip.
Sets an arbitrary timecode value.
Resets the timecode to 00:00:00:00 (execute by
selecting Execute).
Selects the timecode format.
DF: Drop frame
NDF: Non drop frame
Displays the TCG sync source.
Selects the time data to display.

TC/Media > Clip Name Format
Sets clip names. (Clip name: Camera ID + Reel Number + Shot Number + date + random string)
Menu item
Settings
Description
Camera ID
A to Z
Sets the camera ID used when generating clip
names.
Reel Number
001 to 999
Sets the numeric portion of the Reel Number
used when generating clip names.
Camera Position
C/L/R
Sets the first character portion of the Shot
Number used when generating clip names.
TC/Media > Format Media
Formats media.
Menu item
Settings
Execute/Cancel
AXS Slot A
(Only when an AXS-R7
is attached)
Execute/Cancel
AXS Slot B
(Only when an AXS-R7
is attached)

Description
Initializes the AXS memory card in slot A (execute
by selecting Execute).
Initializes the AXS memory card in slot B (execute
by selecting Execute).
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TC/Media > Format Media
Formats media.
Menu item
Settings
SxS Slot A
Execute/Cancel
SxS Slot B

Execute/Cancel

SD Card

Execute/Cancel

TC/Media > Update Media
Updates the media’s management file.
Menu item
Settings
Execute/Cancel
AXS Slot A
(Only when an AXS-R7
is attached)
Execute/Cancel
AXS Slot B
(Only when an AXS-R7
is attached)
SxS Slot A
Execute/Cancel
SxS Slot B

Execute/Cancel

Monitoring Menu
Description
Initializes the SxS memory card in slot A (execute
by selecting Execute).
Initializes the SxS memory card in slot B (execute
by selecting Execute).
Formats the SD card (execute by selecting
Execute).

Description
Updates the management file on the AXS
memory card in slot A of the AXS recorder
(execute by selecting Execute).
Updates the management file on the AXS
memory card in slot B of the AXS recorder
(execute by selecting Execute).
Updates the management file on the SxS memory
card in slot A (execute by selecting Execute).
Updates the management file on the SxS memory
card in slot B (execute by selecting Execute).

Default values are shown underlined and in bold text.
Monitoring > Output Format
Makes settings related to output format.
Menu item
Settings
SDI 1/2
The available settings vary
according to the imager mode,
project frame rate, and SxS
recording format settings.
SDI 3/4
The available settings vary
depending on the SDI 1/2
setting.
Monitor
The available settings vary
depending on the SDI 1/2
setting.
HDMI
The available settings vary
depending on the SDI 1/2
setting.

Description
Selects the SDI 1/2 output format.
Settings vary according to the recording format
(page 64).
Selects the SDI 3/4 output format.
Settings vary according to the recording format
(page 64).
Selects the Monitor output format.
Settings vary according to the recording format
(page 66).
Selects the HDMI output format.
Settings vary according to the recording format
(page 66).

Monitoring > VF OSD
Makes settings related to information and frame lines superimposed on the viewfinder output signal.
Menu item
Settings
Description
Status Info
On/Off
Turns the function to superimpose information on
the viewfinder output signal on/off.
Status Info Select
Info. A/Info. B
Selects the information to display superimposed
on the viewfinder output signal.
Frame Line
On/Off
Turns the function to superimpose frame lines on
the viewfinder output signal on/off.
Frame Line Select
Frame Line A/Frame Line B
Selects the frame lines to display superimposed
on the viewfinder output signal.
Monitoring > SDI OSD
Makes settings related to information and frame lines superimposed on the SDI output signal.
Menu item
Settings
Description
Status Info
On/Off
Turns the function to superimpose information on
the SDI 3/4 output signal on/off.
Status Info Select
Info. A/Info. B
Selects the information to display superimposed
on the SDI 3/4 output signal.
Frame Line
On/Off
Turns the function to superimpose frame lines on
the SDI 3/4 output signal on/off.
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Monitoring > SDI OSD
Makes settings related to information and frame lines superimposed on the SDI output signal.
Menu item
Settings
Description
Frame Line Select
Frame Line A/Frame Line B
Selects the frame lines to display superimposed
on the SDI 3/4 output signal.
Monitoring > Monitor OSD
Makes settings related to information and frame lines superimposed on the Monitor/HDMI output signal.
Menu item
Settings
Description
Status Info
On/Off
Turns the function to superimpose information on
the Monitor/HDMI output signal on/off.
Status Info Select
Info. A/Info. B
Selects the information to display superimposed
on the Monitor/HDMI output signal.
Frame Line
On/Off
Turns the function to superimpose frame lines on
the Monitor/HDMI output signal on/off.
Frame Line Select
Frame Line A/Frame Line B
Selects the frame lines to display superimposed
on the Monitor/HDMI output signal.
Monitoring > HDMI OSD
Makes settings related to information superimposed on the HDMI output signal.
Menu item
Settings
Description
OSD Status
Same as SDI/Same as Monitor
Selects whether the information displayed
superimposed on the HDMI output signal is the
same as for the SDI output signal or Monitor
output signal.
Monitoring > Status Info A
Makes settings related to information displayed on the output image when Status Info Select is set to
“Info. A” for each OSD menu item.
Menu item
Settings
Description
Project
On/Off
Turns the project information display on/off.
On/Off
Turns the timecode information display on/off.
Timecode
On/Off
Turns the audio level meter indicators on/off.
Audio Level Meter
On/Off
Turns the Look type indicator on/off.
Look Status
Output LUT
On/Off
Turns the output LUT information display on/off.
On/Off
Turns the recording LUT information display on/
Recording LUT
off.
VF Status
On/Off
Turns the viewfinder status indicator on/off.
On/Off
Turns the lens information display on/off.
Lens Status

Monitoring > Status Info B
Makes settings related to information displayed on the output image when Status Info Select is set to
“Info. B” for each OSD menu item.
Menu item
Settings
Description
Project
On/Off
Turns the project information display on/off.
On/Off
Turns the timecode information display on/off.
Timecode
On/Off
Turns the audio level meter indicators on/off.
Audio Level Meter
Look Status
On/Off
Turns the Look type indicator on/off.
On/Off
Turns the output LUT information display on/off.
Output LUT
On/Off
Turns the recording LUT information display on/
Recording LUT
off.
VF Status
On/Off
Turns the viewfinder status indicator on/off.
On/Off
Turns the lens information display on/off.
Lens Status
Monitoring > Display Info
Makes settings related to focus position display units.
Menu item
Settings
Focus Distance Format Meter/Feet

Description
Selects the focus position display units.

Monitoring > Frame Line A
Makes settings related to information displayed on the output image when Frame Line is set to Frame
Line A for each OSD menu item.
Menu item
Settings
Description
Center Marker
On/Off
Turns the center marker on/off.
Aspect Ratio
On/Off
Turns the aspect marker on/off.
On/Off
Turns the aspect safety zone marker on/off.
Aspect Safety Zone
On/Off
Turns the picture area indicator on/off.
Picture Area
On/Off
Turns the safety zone indicator on/off.
Safety Zone
On/Off
Turns the user frame lines indicator on/off.
User Frame Line
Monitoring > Frame Line B
Makes settings related to information displayed on the output image when Frame Line is set to Frame
Line B for each OSD menu item.
Menu item
Settings
Description
Center Marker
On/Off
Turns the center marker on/off.
Aspect Ratio
On/Off
Turns the aspect marker on/off.
On/Off
Turns the aspect safety zone marker on/off.
Aspect Safety Zone
On/Off
Turns the picture area indicator on/off.
Picture Area
Safety Zone
On/Off
Turns the safety zone indicator on/off.
On/Off
Turns the user frame lines indicator on/off.
User Frame Line
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Monitoring > Frame Line
Makes settings related to lines and markers displayed on the output image.
Menu item
Settings
Description
Color
White/Yellow/Cyan/Green/
Selects the display color of frame lines.
Magenta/Red/Blue
Center Marker
Cross/Open Cross/Dot
Selects the display form of the center marker.
80%/90%/92.5%/95%
Selects the safety zone range.
Safety Area
Aspect Ratio Type
Line/Mask
Select the display form of the aspect marker.
Line: Displays lines with color set by Color.
Mask: Displays a lower video signal level for areas
outside the marker area.
Aspect Ratio Select
17:9/16:9/15:9/14:9/13:9/4:3/
Selects the mode when displaying the aspect
1.66:1/1.85:1/2.35:1/2.39:1
marker.
Aspect Ratio Mask
0 to 15 (12)
Selects the brightness of the image outside the
aspect marker when Aspect Ratio Type is set to
Mask.
Aspect Safety Area
80%/90%/92.5%/95%
Selects the size (percentage of the entire screen)
of the aspect safety zone marker.
Frame Line on
On/Off
Turns the function to superimpose frame lines
Playback
during playback on/off.
Monitoring > User Frame Line
Makes settings related to the user frame lines.
Menu item
Settings
Width
3 to 479 (240)
Height

3 to 269 (135)

H Position

Max. –476 to 476 (±0)

V Position

Max. –266 to 266 (±0)

Monitoring > VF Display
Makes settings related to the viewfinder display.
Menu item
Settings
VF LUT
Log/s709/R709(800%)
Status Info

On/Off

Description
Sets the user frame line width (distance from the
center to the left and right edges).
Sets the user frame line height (distance from the
center to the top and bottom edges).
Sets the horizontal position of the center of the
user frame lines.
The setting range becomes narrower as the Width
setting increases above 3.
Sets the vertical position of the center of the user
frame lines.
The setting range becomes narrower as the
Height setting increases above 3.

Description
Selects the LUT to apply to the viewfinder output
image.
Turns the function to superimpose information on
the viewfinder output image on/off.

Monitoring > VF Display
Makes settings related to the viewfinder display.
Menu item
Settings
Status Info Select
Info. A/Info. B
Frame Line

On/Off

Frame Line Select

Frame Line A/Frame Line B

Color

–99 to ±0 to +99

Monitoring > VF Function
Makes settings related to viewfinder functions.
Menu item
Settings
Double Speed Scan
On/Off
Peaking Frequency

Normal/High

Zebra
Zebra Select

On/Off
1/2/Both

Zebra1 Level
Zebra1 Aperture Level
Zebra2 Level

0% to 107% (41%)
1% to 20% (10%)
0% to 109% (61%)

Description
Selects the information to display superimposed
on the viewfinder output image.
Turns the function to superimpose frame lines on
the viewfinder output image on/off.
Selects the frame lines to display superimposed
on the viewfinder output image.
Adjusts the color depth of the viewfinder image.

Description
Turns the viewfinder double speed scan function
on/off.
Selects whether the peaking frequency is normal
or high during peaking.
Turns the zebra function on/off.
Selects the zebra pattern type (Zebra 1, Zebra 2,
Both).
Sets the display level of zebra 1.
Sets the aperture level of zebra 1.
Sets the display level of zebra 2.
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Audio > Audio Configuration
Makes settings related to audio input/output.
Menu item
Settings
MIC Input Mono/
Mono/Stereo
Stereo
Phantom Power +48V On/Off

Audio Menu
Default values are shown underlined and in bold text.
Audio > Audio Input
Makes settings related to audio recording levels.
[Note]
The audio recording level with AES/EBU signal selected is fixed.

Menu item
CH-1 Audio Select

Settings
Auto/Manual

CH-2 Audio Select

Auto/Manual

CH-1 Audio Level

–99 to ±0 to +99

CH-2 Audio Level

–99 to ±0 to +99

MIC Reference

–60dB/–50dB/–40dB

Audio > Audio Monitor
Makes settings related to audio monitoring.
Menu item
Settings
Monitor CH
When Monitor Output CH Pair is
set to CH-1/CH-2
CH-1/CH-2, CH-1, CH-2
When Monitor Output CH Pair is
set to CH-3/CH-4
CH-3/CH-4, CH-3, CH-4
Monitor Level
0 to 99
Audio > Audio Configuration
Makes settings related to audio input/output.
Menu item
Settings
Input Limiter Mode
Off/–6dB/–9dB/–12dB/–15dB/
–17dB

AGC Level
AGC Mono/Stereo

Description
Automatically adjusts the audio recording when
set to Auto.
Automatically adjusts the audio recording when
set to Auto.
Adjusts the audio recording level when CH-1
Audio Select is set to Manual.
Adjusts the audio recording level when CH-2
Audio Select is set to Manual.
Selects the reference input level of the
microphone.

Description
Selects the audio channel that is output to the
headphones and speaker.
CH-1/CH-2 (CH-3/CH-4): Channel 1+2 (Channel
3+4)
CH-1 (CH-3): Channel 1 (Channel 3) only
CH-2 (CH-4): Channel 2 (Channel 4) only
Adjusts the monitor audio level.

Description
Selects the limiter characteristic (saturation level)
for large input signals when adjusting the audio
input level manually. Select Off if not using the
limiter.
–6dB/–9dB/–12dB/–15dB/–17dB Selects the AGC characteristic (saturation level).
Mono/Stereo
Automatically adjusts the input level of analog
audio signals recorded on channels 1 and 2, and
selects whether to make the adjustments
separately for each channel (Mono) or in stereo
mode (Stereo).

Monitor Output CH
Pair
Headphone Mono/ST

CH-1/CH-2, CH-3/CH-4
Mono/Stereo

Description
Selects whether the front microphone is
monaural (Mono) or stereo (Stereo).
Turns the function to supply a +48 V external
source (phantom power) to the microphone on/
off.
Sets the audio output channels to either channels
1 and 2 or channels 3 and 4.
Sets the headphones output to monaural (Mono)
or stereo (Stereo).
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Technical > System Configuration
Makes settings related to control of the unit.
Menu item
Settings
SDI Rec Remote
Off/HD SDI Remote I/F/Parallel
Trigger
Rec

Technical Menu
Default values are shown underlined and in bold text.
Technical > Test Signals
Makes settings related to color bars.
Menu item
Settings
Color Bars
On/Off
ARIB/SMPTE
Color Bars Type
On/Off
1KHz Tone on Color
Bars
Test Saw
On/Off
Technical > Switch & Rec Light
Makes settings related to the REC button.
Menu item
Settings
Lock Operator Side
without Rec Button/with Rec
Button
Lock Assistant Side

Rec Light
Rec Start/Stop Beep

without Rec Button/with Rec
Button
On/Off
On/Off

Technical > System Configuration
Makes settings related to control of the unit.
Menu item
Settings
Fan Control
Auto/Max/Off in Rec/Auto/
Off in Rec/Max

Lens Interface

Type C/Off

Description
Turns color bars on/off.
Selects the type of color bars.
Turns the function to output a 1 kHz test signal in
color bars mode on/off.
Turns the test signal on/off.

Description
Sets whether to lock the REC button operation
when buttons are locked using the LOCK switch
on the Operator side.
Sets whether to lock the REC button operation
when buttons are locked using the LOCK switch
on the Assistant side.
Turns the REC lamp on/off.
Turns the function to emit a beep sound when
recording starts and stops on/off.

Description
Selects the fan control mode.
Auto: Controls the fan automatically in response
to the internal temperature.
Max: Fan rotates at maximum speed.
Off in Rec/Auto: The fan is silent when recording,
and operates automatically in response to the
internal temperature when not recording.
Off in Rec/Max: The fan is silent when recording,
and rotates at maximum speed when not
recording.
Sets the lens interface, before attaching a lens,
according to the lens type to attach.
[Note]
If changing this setting while the lens is attached to the
unit, turn the turn off and then on again.

SD HDMI

On/Off

Shutter Mode

Speed/Angle

Description
Selects the SDI remote mode control method.
Off: Disables remote control.
HD SDI Remote I/F: Uses HD SDI Remote control
method.
Parallel Rec: Uses valid flag control method.
Turns the function to set the HDMI output signal
to SD format on/off.
Selects the operating mode of the electronic
shutter.

Technical > APR
Executes APR (Auto Pixel Restoration: auto adjustment of the image sensor).
Menu item
Settings
Description
APR
Execute/Cancel
Executes the automatic pixel noise reduction
function (execute by selecting Execute).
Reset
Execute/Cancel
Deletes white flecks added by execution of the
APR and automatic black balance adjustment
functions (execute by selecting Execute).
Technical > Battery
Makes settings related to batteries.
Menu item
Settings
Near End:Info Battery
5% to 100% (5% increments)

End:Info Battery

0% to 5%

Near End:Sony Battery

11.5V to 17V (0.1V increments)

End:Sony Battery

11.0V to 11.5V (0.1V increments)

Near End:Other Battery 11.5V to 17V (11.8V) (0.1V
increments)
End:Other Battery

11.0V to 14V (0.1V increments)

Detected Battery

Sony Info Battery/Sony Battery/
Other Battery/DC IN (12V)/DC IN
(24V)

Description
Sets the threshold value at which the remaining
battery capacity indicator starts flashing when
using an InfoLithium battery.
Sets the threshold value for displaying the “Battery
End” warning when using an InfoLithium battery.
Sets the threshold value at which the remaining
battery capacity indicator starts flashing when
using a Sony non-InfoLithium battery.
Sets the threshold value for displaying the “Battery
End” warning when using a Sony non-InfoLithium
battery.
Sets the threshold value at which the remaining
battery capacity indicator starts flashing warning
when using a non-Sony battery.
Sets the threshold value for displaying the “Battery
End” warning when using a non-Sony battery.
Displays the result of automatic battery pack type
detection.
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Technical > DC Voltage Alarm
Sets alarms relating to external DC supply voltage.
Menu item
Settings
DC Low Voltage1
11.5V to 17V (0.1V increments)

DC Low Voltage2

11.0V to 14V (0.1V increments)

DC(24V) Low Voltage1

22.5V to 34.0V (0.1V increments)

DC(24V) Low Voltage2

22.0V to 28.0V (0.1V increments)

Technical > Control Display
Makes settings related to the displays.
Menu item
Settings
Brightness level
High/Mid/Low/Minimum
Technical > Genlock
Makes settings related to genlock.
Menu item
Settings
Input Source
HD SDI/Analog

Reference Lock Type

Internal/External(HD)/
External(SD)

Maintenance Menu
Description
Sets the threshold value for displaying a low
voltage warning when using an external power
source connected to the DC IN connector.
Sets the threshold value for displaying an
undervoltage warning when using an external
power source connected to the DC IN connector.
Sets the threshold value for displaying a low
voltage warning when using a 24 V external
power source connected to the DC IN connector.
Sets the threshold value for displaying an
undervoltage warning when using a 24 V external
power source connected to the DC IN connector.

Default values are shown underlined and in bold text.
Maintenance > Clock Set
Makes settings related to the built-in clock.
Menu item
Settings
Time Zone
UTC + 14:00 to UTC Greenwich
to UTC – 12:00 (30-minute
increments)
Date Mode
YYMMDD/MMDDYY/DDMMYY

Date
Time

Description
Selects the difference in time from UTC
(Greenwich Mean Time) in units of 30 increments.
Selects the display format for dates.
YYMMDD: Year, month, day
MMDDYY: Month, day, year
DDMMYY: Day, month, year
Sets the current date (apply by pressing Set).
Sets the current time (apply by pressing Set).

Description
Adjusts the brightness of the sub display and mini
display.

Maintenance > Language
Selects the display language for menus and messages.
Menu item
Settings
Description
Select
Selects the display language for the full menu and
English/ 中文(简)
messages.

Description
Selects the genlock input signal.
HD SDI: Digital
Analog: Analog
Displays the genlock status. Displays the signal
type when genlocked.
Internal: Not genlocked.
External(HD): Genlocked by the HD signal.
External(SD): Genlocked by the SD signal.

Maintenance > Hours Meter
Displays the accumulated usage time.
Menu item
Settings
Camera(System)
R7 Recorder
(System)
(Only when an AXS-R7
is attached)
Camera(Resettable)
R7 Recorder
(Resettable)
(Only when an AXS-R7
is attached)
Reset-Cam
(Resettable)
Reset-R7
(Resettable)
(Only when an AXS-R7
is attached)

Description
Displays the accumulated time of use of the unit
(cannot be reset).
Displays the accumulated time of use of the AXS
recorder connected to the unit (cannot be reset).

Displays the accumulated time of use of the unit
(can be reset).
Displays the accumulated time of use of the AXS
recorder connected to the unit (can be reset).

Execute/Cancel
Execute/Cancel

Resets the Camera(Resettable) display to 0
(execute by selecting Execute).
Resets the R7 Recorder(Resettable) display for the
AXS recorder connected to the unit to 0 (execute
by selecting Execute).
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Maintenance > Reset to Default
Returns the unit to factory default state.
Menu item
Settings
Reset
Execute/Cancel
Maintenance > License Options
Installs software options.
Menu item
Settings
Install: <target_
Execute/Cancel
license>
Anamorphic
Permanent License Installed/
XX days Remaining (YY keys)/
Expired/Not Installed

Full Frame

Unique Device ID

Permanent License Installed/
XX days Remaining (YY keys)/
Expired/Not Installed

Description
Initializes all unit settings (execute by selecting
Execute).

Description
Installs software options (execute by selecting
Execute).
Displays whether the Anamorphic option is
enabled.
Permanent License Installed: Permanent license is
installed
XX days Remaining (YY keys): Expiration of timed
license
Expired: Timed license has expired
Not Installed: Not installed
Displays whether the Full Frame option is
enabled.
Permanent License Installed: Permanent license is
installed
XX days Remaining (YY keys): Expiration of timed
license
Expired: Timed license has expired
Not Installed: Not installed
Displays the ID used for issuing the software
option license key.

Maintenance > Firmware
Displays the version of the unit and AXS recorder, and updates the unit.
Menu item
Settings
Description
Camera
Displays the firmware version of the unit (Vx.xx).
Displays the firmware version of the AXS recorder
AXS
connected to the unit (Vx.xx).
(Only when an AXS-R7
is attached)
FW Update-camera
Execute/Cancel
Updates the unit (execute by selecting Execute).
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Clip Operations
Clip operations are performed using the clip list screen and the playback screen. You can play a clip by
selecting the clip to play from the clip list screen displayed on the sub display.
When AXS Rec Format is not set to Rec Off in the Project category in the menu, AXS media becomes
playable. Similarly, when SxS Rec Format is not set to Rec Off, SxS media becomes playable.

8. Format (codec)
Displays the recording format (codec) of the
clip indicated by the cursor.

9. Project frame rate/picture size indicator
Displays the project frame rate and picture size
of the clip indicated by the cursor.

Clip List Screen

10. Duration (Dur)

Press the CLIPS button (page 8) on the Assistant side to display the clip list screen for playable media
on the sub display.

11. Timecode (TCR)

Displays the duration of the clip indicated by
the cursor.

1

2

3

SxS / AXS

12
11
10
9
8
7
6

12. Active playback media

Play

SxS A

A001C001_180101CQ

Sub OK

TCR 00:00:00:00

A001C002_180101G7

Sub OK

Dur 00:00:01:56

A001C003_180101HR

Sub OK

23.98fps 4K 4:3 2x

A001C004_180101WK

Sub OK

A001C005_180101S8

Sub OK

A001C006_180101GF

Sub OK

XAVC QFHD C480
2018/1/1 11:30

Displays the active playback media of the
displayed list.

4

002/010

5
1. Media select button
Displays “SxS/AXS” if both SxS and AXS media
are playable. Press ITEM key 1 to switch the
playback media.

Icon

Meaning
Clip with a created sub clip
Locked (write protection) clip

2. Cursor up button
Press ITEM key 2 to select the clip to play from
the clip list.

3. Playback start button
Press ITEM key 3 to display the playback screen
(page 13) and start playback.

4. Clip list
Displays a list of clips on the active playback
media. It also displays the clips status using
icons.

Displays the timecode of the first frame of the
clip indicated by the cursor.

5. Cursor down button
Press ITEM key 5 to select the clip to play from
the clip list.

6. Clip position in playback media
Displays the number of the clip indicated by
the cursor and total number of clips.

7. Creation date and time
Displays the creation date and time of the clip
indicated by the cursor.
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Status display area

Playback Screen

1

The playback screen is displayed when you select a clip to play on the clip list screen and press the MENU
dial or Play button (ITEM key 3).

Dur

9
8

Function display area

1
F R ev

2

3

Play/ Pause

F Fwd

00: 00: 00: 00 23.98fps

Dur

x24
SXS

A001C002_160328WW

Displays the timecode of the playback
position.

002/010 X AVC QFHD C480

A 001C 002_160328WW

x24 DC IN 15.0V
002/010 XAVC QFHD C480
SXS A

1. Time data display

3.8K 16:9

1 2

S ub OK

Prev

Stop/Clips

Next

4

5

6

2. Clip number
Displays the Current playback clip number/
Total number of playable clips.

3. Frame rate/imager mode indicator
Displays the project frame rate and picture
size.

4. Audio level meters
1. F Rev button
Play back at high speed in the reverse
direction.

2. Play/Pause button
Play a clip or pause playback.

3. F Fwd button
Play back at high speed in the forward
direction.

4. Prev button
Skip to the start of the previous clip.

5. Stop/Clips button
Stop playback and return to the clip list screen.

6. Next button
Skip to the start of the next clip.

Displays the playback audio level.

5. Playback clip format (codec) indicator
Displays the format (codec) of the playback
clip.

6. Icon display
Displays the clip status using icons.
Icon

3

00:00:00:00 23.98fps 3.8K 16:9

7

DC IN 15.0 V FPS 60

A

2

Meaning
Clip with a created sub clip
Locked (write protection) clip

1 2

Sub

6

4

5
7. Clip name indicator
Displays the name of the clip.

8. Media indicator
Displays the media being played.

9. Playback status indicator
Displays the playback status.
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Playback
You can play recorded clips while the unit is in
standby mode.

Playback operations

Switching to an AXS memory card

[Note]

Playback operation is performed using the buttons
on the sub display (page 53).
Play/Pause button: Pause playback. To resume
playback, press this button again.
F Fwd button/F Rev button: Fast forward/reverse.
To return to normal playback, press the Play/
Pause button.
Stop/Clips button: Stop playback and return to the
clip list screen.

You can quickly play video recorded on an AXS
memory card in the AXS-R7.
To switch to an AXS memory card, press ITEM key
1 (page 27) on the sub display.
The playback signal is output from the output
connector of the unit.

The playback controls appear on ITEM keys 1 to 6
(page 7). Press an ITEM key to select the corresponding
item.

1
2
3
4

Insert the SxS memory card to play .
Press the CLIPS button (page 8) on the
Assistant side.
The clip list on the active playback media
appears on the sub display.

Monitoring audio

Press the
button (ITEM key 2),
button
(ITEM key 5), or MENU dial to select a clip to
play.
Press the MENU dial or the Play button (ITEM
key 3).
The playback image appears on the viewfinder
screen.
BAT 120 min

In normal playback mode, you can monitor the
recorded audio through the built-in speaker
(page 6) or connected headphones.
When headphones are connected to the
headphones connector (page 6), the built-in
speaker is turned off.
You can select the channel to monitor and adjust
the volume using Audio category > Monitor CH
and Monitor Level (page 38) in the menu.

Cueing up
To play from the start of a clip, press the Prev
button on the sub display (page 27).
You can skip clips and cue-up another clip
by pressing the Prev button or Next button
repeatedly.
12:34:56:00

A001C001

Play

XCON ST

AXS A

1

2

Switching the SxS memory cards
When two SxS memory cards are loaded, press
the SLOT SELECT button (page 7) to switch
memory cards.
[Note]
You cannot switch SxS memory cards during playback.
Continuous playback of cards in slots A and B is not possible.
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Operations on the Home Screen of the Mini Display
You can check the status of the unit and set basic
settings for the unit on the Home screen of the
mini display.

1
2
3
4
5

24
180.0
Clear
500
5600+00

FPS Fixed
ND
El
WB

1. FPS
Displays the video frame rate.

2. Shutter
Displays and sets the shutter speed/shutter
angle of the electronic shutter.

3. ND Filter

Controls
HOME button (page 6)
Press to return to the Home screen. Unconfirmed
changes are canceled.

Basic Operation

1
2

ITEM key 1 ( ) (page 6)
Press to select items on the Home screen.

Press ITEM key 1, 2, or 3.
The cursor appears.
Select the item to set using the
button
(ITEM key 1) or
button (ITEM key 3).

24
180.0
Clear
500
5600+00

FPS Fixed

ITEM key 2 ( ) (page 6)

ND
El
WB

Press to apply the selected item.

ITEM key 3 ( ) (page 6)
Press to select items on the Home screen.

3

Displays and sets the density of the ND filter.

Press the button (ITEM key 2).
The setting value selection screen appears for
the selected item.

4. Exposure Index
Displays and sets the exposure index (EI).

320
400
500
640

5. WB (White Balance)
Displays and sets the white balance.

El

[Note]
The

4
5
6

mark indicates the current setting.

Move the cursor to the item or setting value
using the
button (ITEM key 1) or
button
(ITEM key 3).
Press the
setting.

button (ITEM key 2) to apply the

Press the HOME button to hide the cursor.
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Home Screen Items on the Mini Display
The names of items and corresponding setting values are given below.
Default values are shown underlined and in bold text.
Item
FPS

Description
Displays the video frame rate. The setting is determined by the Project category >
Project Frame Rate setting (page 36) in the menu.
Project Frame Rate

Exposure Index

Shutter

23.98

Display
Fixed 24

24
25
29.97
50
59.94

Fixed 24
Fixed 25
Fixed 30
Fixed 50
Fixed 60

Sets the EI value. The following settings are available.
125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/
1250EI/1600EI/2000EI
Sets the electronic shutter angle/shutter speed.
Select from preset values registered as shutter steps.
[Note]
Not available when the electronic shutter operation is set to Continuous.

ND Filter
WB (White Balance)

1)

Displays the following selection options depending on the Technical > System
Configuration > Shutter Mode (page 49) setting in the full menu.
Angle (Δ): Shutter angle indicator
360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2 1)
Speed (SS): Shutter speed indicator
1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 1)
Sets the density of the ND filter. The following settings are available.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4
Sets the color temperature of the white balance.
Select from preset values registered as WB steps.
3200K+00/4300K+00/5500K+00 1)

The selection options can be changed using Step Edit on the Home screen of the sub display.
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Basic Operations
Basic recording can be performed with the
following procedures.

Clip names

1

Clip names are recorded using the “Cam ID +
Reel#” format. The clip name is created according
to the following rules.
ˎˎWhen there is already a clip that is stored using
the “Cam ID + Reel#” name format on the
inserted SxS memory card or AXS memory card,
the new file inherits from the last file.
Example: If “B002C003_XXXXXXXX” exists on the
AXS memory card, the next created clip will be
named “B002C004_XXXXXXXX.”
ˎˎIf the inserted AXS memory card has no files, “1”
is added to the Reel Number of the clip that was
recorded last.
Example: If you record on empty card 2 after
recording up to “D001CXXX_XXXXXXXX” on
card 1, the next created clip will be named
“D002C001_XXXXXXXX.” The clip name flashes
until recording starts.
ˎˎIf you set Camera ID and Reel Number using TC/
Media category > Clip Naming in the menu, that
information is applied.
Example: If you change Camera ID to “F” and
Reel Number to “001” in the menu for the
AXS memory card that has recorded up to
“E003CXXX_XXXXXXXX,” the next clip will
be named “F001CXXX_XXXXXXXX.” When
you change Camera ID only, Reel Number is
changed to “001.”

2
3
4

Make sure that the necessary devices are
attached to the unit and power is supplied to
them.
Set the power switch (page 6) to the ON
position.
The recording screen is displayed on the
viewfinder screen.
Load the memory card(s).
If you load two SxS memory cards, recording is
continued by automatically switching to the
second card when the first card becomes full.
Press the REC button (pages 6, 8).
The REC lamp lights and recording begins.
[Note]
If the unit cannot start recording immediately after the
pressing the REC button, the REC lamp flashes. The REC
lamp lights when recording starts.

5

To stop recording, press the REC button again.
Recording stops and the unit enters STBY
(recording standby) mode.
When you stop recording, the video, audio,
and subsidiary data from the start to the end
of the recording are recorded as a single clip.

Maximum duration of a clip
The maximum single clip length that you can
record to an SxS memory card is 6 hours.
Recording stops if the recording time exceeds the
maximum clip duration.
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Useful Functions
Simultaneous Recording (Simul Rec)

Recording Review (Rec Review)

Focus Magnifier Function

You can simultaneously record two sizes of
pictures on an SxS memory card in one slot. You
can also simultaneously record an HD signal on an
SxS memory card in the unit while recording video
and audio in RAW format on the AXS-R7.
You can perform simultaneous recording using
Project category > AXS Rec Format and SxS Rec
Format or SxS Rec Format and Sub Rec Format
in the menu as described in “Recording Format
Settings” (page 39).

You can review the last recorded clip on the
screen by assigning the Rec Review function to
one of assignable buttons 1 to 4 (page 32).
When you stop recording and press the button
assigned with Rec Review, the clip is played at
normal speed starting from the first frame.
The clip is played to the end, then Rec Review
ends and the unit returns to STBY (recording
standby) mode.
If the HOME button is pressed on the Operator
side or Assistant side during playback, playback
stops and the unit switches to shooting mode.

By pressing the FOCUS MAG button of the
viewfinder (DVF-EL200, DVF-L700) attached to
the unit, you can expand the center part of the
viewfinder, making it is easier to adjust the focus.
After adjusting the focus, press the button again to
return to the normal (recording) screen.
The magnified display does not affect the recorded
image or output signal.

[Note]
In simultaneous recording mode, the unit cannot switch to
the second card automatically even if a card becomes full.

Viewfinder Double Speed Scan
Function
If the project frame rate is 23.98P, 24P, 25P, or
29.97P, the image may become blurred and hard
to see due to low frame frequency when you
shoot while swaying the unit to the right and the
left.
In this case, you can decrease image blur and
make it easier to see by activating the viewfinder
double speed scan function.
To activate the function, set Monitoring category >
Moni. Details > VF Function > Double Speed Scan
(page 47) in the menu to On.
[Note]

In 1-slot simultaneous recording, the XAVC 4K
Class480/XAVC 4K Class300/XAVC QFHD Class480/
XAVC QFHD Class300 clip is recorded in the
XDROOT/Clip directory on the SxS memory card,
but the MPEG2 1920×1080 clip is recorded in the
XDROOT/Sub directory on the SxS memory card.
The suffix “S02” is appended to the end of the clip
name.

When this function is activated, the shutter angle of the
electronic shutter function is limited to 180 degrees or lower.
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Connecting External Monitors and Recording Devices
To display the recording/playback image on an
external monitor, select the output signal and
use an appropriate cable for the monitor to be
connected.
The output signal from the unit can be recorded
by connecting a recording device, such as a VTR.
The same status information and menus can be
displayed on the external monitor as those on
the viewfinder screen. Set the content to display,
according to the output signal for the monitor,
using the Monitoring menu (page 45).

SDI OUT Connector (BNC Type)
Set the output format using the Monitoring menu
(page 45).
Use a commercially available 75-ohm coaxial cable
for connection.
[Note]
Check that the ground connection between the unit and
external device is securely grounded before turning the
power on. (We recommend turning on the unit and external
device after connecting a 75-ohm coaxial cable.)
When connecting an external device to the unit while the
unit is turned on, connect to the unit after connecting a 75ohm coaxial cable to the external device.

To start synchronized recording on an external
device
With SDI signal output selected, synchronized
recording is possible by feeding a REC
trigger signal to an external recording device
connected to the SDI OUT connector. Enable
synchronized recording by setting Technical >
System Configuration > SDI Rec Remote Trigger
(page 49) in the menu to HD SDI Remote I/F or
Parallel Rec.
[Note]
When a connected external device does not support a REC
trigger signal, the device cannot be operated.

MONITOR OUT Connector (BNC Type)
Outputs an HD SDI signal.
Set the output format using the Monitoring menu
(page 45).
Use a commercially available 75-ohm coaxial cable
for connection.

12V OUT Connector (DC OUT 12V,
Hirose 4-pin)

24V OUT Connector (DC OUT 24 V,
Fischer 3-pin)

Supplies 12 V DC power to an accessory when the
power switch is set to ON. You can output a REC
Tally signal and input a REC Trigger signal through
the 12V OUT connector.

Supplies 24 V DC power to an accessory when the
power switch is set to ON. You can output a REC
Tally signal and input a REC Trigger signal through
the 24V OUT connector.

HDMI OUT Connector (Type A
Connector)
Set the output format using the Monitoring menu
(page 45).
Use a commercially available HDMI cable for
connection.
If the output format has the same resolution as the
MONITOR OUT connector signal, the same video
signal is output.

No. Signal
1
UNREG GND
2
REC TALLY

I/O
–
OUT

3

REC TRIGGER

IN

4

UNREG +12 V
OUT

OUT

Specification
GND for UNREG
Open-collector
output
(Max. 50 mA)
Low: REC
Open or +5 V DC:
Normal
GND: Active (REC)
+11 V to 17 V DC
output
11 V to 17 V input
Output voltage:
Same as the input
voltage
Maximum output
current: 1.0 A
22 V to 32 V input
Output voltage :
15 V
Maximum output
current: 0.8 A

No.
1
2

Signal
GND
24V-AUX

3

R/S

Specification
11 V to 17 V input
Output voltage : 24 V
Maximum output current:
1.0 A
22 V to 32 V input
Output voltage: Same as
the input voltage
Maximum output current:
2.0 A
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AUX Connector (LEMO 5-pin)
Outputs the timecode signal.

No.
1
2
3
4
5

Signal
Factory Use
NC
–
TC OUT
GND
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External Synchronization
When shooting with multiple units, synchronized
recording can be performed using a specific
reference signal to synchronize the timecode
among all the units.

You can check the genlock status using Technical
> Genlock > Reference Lock Type (page 50) in
the menu.
[Notes]
ˎˎ If the reference signal is unstable, genlock is not possible.
ˎˎ The subcarrier is not synchronized.

Synchronizing the Phase of the Video
Signal (Genlock)
Genlock operation is enabled by supplying one of
the following reference signals to the GENLOCK IN
connector (page 9) of the unit.
ˎˎHDSDI 1.5G digital I (Interlaced or PsF)
ˎˎHD Y analog
ˎˎSD VBS analog
Set the genlock input signal using Technical >
Genlock > Input Source (page 50) in the full
menu.
Valid input reference signals vary depending on
the project frame rate setting.
Project frame
rate
23.98P
24P
25P
29.97P
50i
50P
59.94i
59.94P

Valid reference signal
1920×1080 47.95i (23.98PsF)
1920×1080 48i (24PsF)
1920×1080 50i
720×576 50i
1920×1080 59.94i
720×486 59.94i
1920×1080 50i
720×576 50i
1920×1080 50i
720×576 50i
1920×1080 59.94i
720×486 59.94i
1920×1080 59.94i
720×486 59.94i

Synchronizing the Timecode with
Another Device
Set the unit that supplies the timecode to a mode
in which the timecode output keeps advancing
(Free Run mode).

1
2

Set TC/Media > Timecode > Mode (page 44)
in the menu to Preset F-Run (Ext-Lk).
Supply an HD or SD reference video signal to
the GENLOCK IN connector (page 9) and a
reference timecode synchronized with that
signal to the TC IN (page 9) connector.

The built-in timecode generator of your unit locks
to the reference timecode, and the message “ExtLk” is displayed on the screen.
Once about ten seconds have elapsed after
the timecode locks, the external lock state is
maintained even if the external timecode source is
disconnected.
[Notes]
ˎˎ Check that the reference timecode and the reference
video signal are in a phase relationship that complies with
the SMPTE timecode standards.
ˎˎ When you finish the above procedure, the timecode is
immediately synchronized with the external timecode,
and the time data indication will show the value of the
external timecode. However, wait for a few seconds until
the timecode generator stabilizes before recording.
ˎˎ If the frequency of the reference video signal and the
frame frequency are not the same, lock cannot be
acquired, and the unit will not operate properly. If this
occurs, the timecode will not acquire successful lock with
the external timecode.
ˎˎ When the connection is removed, the timecode advance
may shift one frame per hour with respect to the
reference timecode.

To release external lock
Change the TC/Media > Timecode > Mode
(page 44) setting in the menu.

000
62

6. Appendix

Usage Precautions
Read this section in conjunction with the
information provided in the supplied “Before Using
this Unit” document.

Use and Storage
Do not subject the unit to severe shock
The internal mechanism may be damaged or the
body warped.

Do not cover the unit while operating
Putting a cloth, for example, over the unit can
cause excessive internal heat build-up.

After use
Always set the power switch to OFF.

Care of the Unit
If the body of the unit is dirty, clean it with a soft,
dry cloth. In extreme cases, use a cloth moistened
in a little neutral detergent, then wipe dry.
Do not use organic solvents, such as alcohol or
thinners, as these may cause discoloration or other
damage to the finish of the unit.
Refrain from cleaning with high air pressure
equipment, such as an air duster, as these may
damage optical components.

In the event of operating problems
If you should experience problems with the unit,
contact your Sony dealer.

Periodic Replacement of Fan and
Battery

Before storing the unit for a long period
Remove the battery pack.

Do not leave the unit with the lens facing the sun
Direct sunlight can enter through the lens, be
focused in the unit, and cause fire.

The fan and battery are consumable parts that will
need periodic replacement.
When operating at room temperature, a
normal replacement cycle will be about 5 years.
However, this replacement cycle represents only
a general guideline and does not imply that the
life expectancy of these parts is guaranteed. For
details on parts replacement, contact your dealer.

Shipping
ˎˎRemove the memory cards before transporting
the unit.
ˎˎIf sending the unit by truck, ship, air or other
transportation service, pack it in the shipping
carton of the unit.

Life Expectancy of the Electrolytic
Capacitor
The life expectancy of the electrolytic capacitor
is about 5 years under normal operating
temperatures and normal usage (8 hours per day;
25 days per month).

If usage exceeds the above normal usage
frequency, the life expectancy may be reduced
correspondingly.

To prevent electromagnetic interference from
portable communications devices

Note about the Battery Terminal

The use of portable telephones and other
communications devices near this unit can result
in malfunctions and interference with audio and
video signals.
It is recommended that the portable
communications devices near this unit be
powered off.

The battery terminal of this unit (the connector for
battery packs and AC adaptors) is a consumable
part.
Power may not be supplied to the unit properly
if the pins of the battery terminal are bent or
deformed by shock or vibrations, or if they become
corroded due to prolonged outdoor use.
Periodic inspections are recommended to keep
the unit working properly and to prolong its
usable lifetime.
Contact a Sony service or sales representative for
more information about inspections.

Use and Storage Locations
Store in a level, ventilated place.
Avoid using or storing the unit in the following
places.
ˎˎIn excessive heat or cold (operating temperature
range: 0 °C to 40 °C (32 °F to 104 °F))
Remember that in summer in warm climates
the temperature inside a car with the windows
closed can easily exceed 50 °C (122 °F).
ˎˎIn damp or dusty locations
ˎˎLocations where the unit may be exposed to
rain
ˎˎLocations subject to violent vibration
ˎˎNear strong magnetic fields
ˎˎClose to radio or TV transmitters producing
strong electromagnetic fields.
ˎˎIn direct sunlight or close to heaters for
extended periods

Note on laser beams
Laser beams may damage the CMOS image
sensor. If you shoot a scene that includes a laser
beam, be careful not to let the laser beam be
directed into the lens of the unit. Specifically, highpower laser beams from medical devices or other
devices may cause damage due to reflected light
and scattered light.

About the Screens
ˎˎDo not leave the screens facing direct sunlight,
as this may damage the screens.
ˎˎDo not press/swipe the screens forcefully, or
leave objects on the screens, as it may cause a
malfunction, such as picture irregularity, etc.
ˎˎThe screens may become warm in use. This is
not a malfunction.
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LCD and OLED Panels
The LCD panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck”,
either always off (black), always on (red, green, or
blue), or flashing. In addition, over a long period
of use, because of the physical characteristics of
the liquid crystal display, such “stuck” pixels may
appear spontaneously.
These problems are not a malfunction.
Note that any such problems have no effect on
recorded data.
The OLED (organic light emitting diode) panel
of this unit may also exhibit “stuck” pixels and/
or bright spots. These problems are not a
malfunction.

On Condensation
If the unit is suddenly taken from a cold to a warm
location, or if ambient temperature suddenly
rises, moisture may form on the outer surface of
the unit and/or inside of the unit. This is known
as condensation. If condensation occurs, turn off
the unit and wait until the condensation clears
before operating the unit. Operating the unit while
condensation is present may damage the unit.

Phenomena Specific to CMOS Image
Sensors
The following phenomena that may appear in
images are specific to CMOS (Complementary
Metal Oxide Semiconductor) image sensors. They
do not indicate malfunctions.

White flecks

Notes on the Display

Output Voltages of the Unit

Although the CMOS image sensors are produced
with high-precision technologies, fine white
flecks may be generated on the screen in rare
cases, caused by cosmic rays, etc. This is related
to the principle of image sensors and is not a
malfunction.
The white flecks especially tend to be seen in the
following cases.
ˎˎWhen operating at high environmental
temperatures

ˎˎPictures on the viewfinder screen may be
distorted by the following operations.
– Changing the video format
ˎˎWhen you change the line of sight in the
viewfinder, you may see primary colors red,
green, and blue, but this is not a defect of the
unit. These primary colors are not recorded on
any recording media.

The total output power that can be supplied to
peripheral devices from the unit varies depending
on the input voltage to the unit and the state of
the connected accessories. The maximum output
capacity ratings of the following connectors
that can supply power may not be achieved
depending on the conditions.
LENS connector: 1 A max.
12V OUT connector (4-pin):
0.8 A max. (Input voltage: 22 V to 32 V)
1 A max. (Input voltage: 11 V to 17 V)

Aliasing
When fine patterns, stripes, or lines are shot, they
may appear jagged or flicker.

Focal plane
Owing to the characteristics of the pickup
elements (CMOS sensors) for reading video signals,
subjects that quickly move across the screen may
appear slightly skewed.

Flashbanding

Fragmentation
If pictures cannot be recorded/reproduced
properly, try formatting the recording medium.
While repeating picture recording/playback with
a certain recording media for an extended period,
files in the media may be fragmented, disabling
proper recording/storage. In such a case, make
a backup of clips in the media then perform
formatting of the media using TC/Media > Format
Media (page 44) in the menu.

24V OUT connector (3-pin):
2 A max. (Input voltage: 22 V to 32 V)
1 A max. (Input voltage: 11 V to 17 V)
When an AXS-R7 and DVF-EL200 are attached and
the input voltage to the unit is 14 V or lower, the
power rating available for peripheral devices is
limited.
Total power rating of peripheral devices: Y [W]
Voltage of power supply to the unit: X [V]
Power consumption of the unit: Approx. 60 W
Power consumption of the AXS-R7:
Approx. 24 W
Power consumption of the DVF-EL200:
Approx. 2.5 W

The luminance at the top and bottom of the
screen may change when shooting a flashlight
beam or a light source that quickly flashes.

Y [W] = X [V] × 9.0 [A] 1) – (60 + 24 + 2.5) [W]

Flicker
If recording is made under lighting produced
by discharge tubes, such as fluorescent, sodium,
or mercury-vapor lamps, the screen may flicker,
colors may vary, or horizontal stripes may appear
distorted.

When supplying power from the unit to
peripheral devices, make sure that the total power
requirement does not exceed the total power
rating given by the equation above.
(Note that the equation does not apply if the
calculated result exceeds the sum of the maximum
allowable output power of each power output
connector.)
1)

6.0 [A] when using the AC-DN10.
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Recording Formats and Output Signals
SDI OUT Connector Output Formats
The serial digital signal from an SDI OUT connector is output according to the Project category and Monitoring category settings in the menu.
For details about Project category settings combinations, see “Recording Format Settings” (page 39).
Default values are shown underlined and in bold text.
Project
Project Frame Rate
59.94/50

Imager Mode
4K 17:9

3.8K 16:9

29.97/25

4K 17:9/
3.8K 16:9
4K 17:9

3.8K 16:9

24

4K 17:9/
3.8K 16:9
6K 3:2/4K 4:3/
4K 17:9

SxS Rec Format
XAVC-I 4K Class300/
Rec Off

XAVC-I QFHD
Class300/Rec Off

MPEG 1920×1080i
XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

Monitoring > Output Format
SDI 1/2
SDI 3/4
4096×2160P 2SI
4096×2160P 2SI
4096×2160P Square
4096×2160P Square

1920×1080i

1920×1080P YPbPr 3G
Level B-DL
1920×1080i YPbPr 1.5G

SDI 2
SDI 3
4096×2160P YPbPr 3G Level B-DL
4096×2160P YPbPr 3G Level B-DL
2048×1080P YPbPr 3G
1920×1080i YPbPr 1.5G
Level B-DL
1920×1080P YPbPr 3G
1920×1080i YPbPr 1.5G
Level B-DL
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
3840×2160P YPbPr 3G Level B-DL
3840×2160P YPbPr 3G Level B-DL
1920×1080P YPbPr 3G
1920×1080i YPbPr 1.5G
Level B-DL
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G

1920×1080i

1920×1080i

1920×1080i YPbPr 1.5G

1920×1080i YPbPr 1.5G

4096×2160P 2SI
4096×2160P Square

–
4096×2160P Square

2048×1080PsF

1920×1080PsF

1920×1080PsF

1920×1080PsF

2048×1080P

1920×1080i

1920×1080P

1920×1080i

1920×1080i
3840×2160P 2SI
3840×2160P Square

1920×1080i
3840×2160P 2SI
3840×2160P Square

1920×1080P

1920×1080i

1920×1080i

XAVC-I QFHD Class480/ 3840×2160P 2SI
XAVC-I QFHD
3840×2160P Square
Class300/Rec Off
1920×1080PsF
MPEG 1920×1080P
XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

Output format
SDI 1

–
3840×2160P Square
1920×1080PsF

1920×1080PsF

1920×1080PsF

4096×2160P 2SI
4096×2160P Square

–
4096×2160P Square

2048×1080P

1920×1080P

1920×1080P

1920×1080P

2048×1080P YPbPr 3G
Level B-DL
1920×1080P YPbPr 3G
Level B-DL
1920×1080i YPbPr 1.5G

1920×1080i YPbPr 1.5G

4096×2160P YPbPr 3G Level B-DS
No output
4096×2160P YPbPr 1.5G
2048×1080PsF
2048×1080PsF
1920×1080PsF
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
1920×1080PsF
1920×1080PsF
1920×1080PsF
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
3840×2160P YPbPr 3G Level B-DS

No output

3840×2160P YPbPr 1.5G
1920×1080PsF
1920×1080PsF
1920×1080PsF
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
1920×1080PsF
1920×1080PsF
1920×1080PsF
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
4096×2160P YPbPr 3G Level B-DS
No output
4096×2160P YPbPr 1.5G
2048×1080PsF
2048×1080PsF
1920×1080P
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
1920×1080PsF
1920×1080PsF
1920×1080P
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G

SDI 4

1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G

1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
No output
1920×1080PsF
YPbPr 1.5G
1920×1080PsF
YPbPr 1.5G
No output
1920×1080PsF
YPbPr 1.5G
1920×1080PsF
YPbPr 1.5G
No output
1920×1080P
YPbPr 1.5G
1920×1080P
YPbPr 1.5G
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Project
Project Frame Rate
23.98

Imager Mode
6K 3:2/
4K 4:3/
4K 17:9

3.8K 16:9

4K 4:3/
4K 17:9/
3.8K 16:9

SxS Rec Format
XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

Monitoring > Output Format
SDI 1/2
SDI 3/4
4096×2160P 2SI
–
4096×2160P Square
4096×2160P Square
2048×1080P

–

1920×1080P

1920×1080P

XAVC-I QFHD Class480/ 3840×2160P 2SI
XAVC-I QFHD
3840×2160P Square
Class300/
1920×1080P
Rec Off

–
3840×2160P Square
1920×1080P

MPEG 1920×1080P
1920×1080P

1920×1080P

Output format
SDI 1
SDI 2
SDI 3
4096×2160P YPbPr 3G Level B-DS
No output
4096×2160P YPbPr 1.5G
2048×1080PsF
2048×1080PsF
1920×1080P
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
1920×1080PsF
1920×1080PsF
1920×1080P
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
3840×2160P YPbPr 3G Level B-DS
No output
4096×2160P YPbPr 1.5G
1920×1080PsF
1920×1080PsF
1920×1080P
YPbPr 1.5G
YPbPr 1.5G
YPbPr 1.5G
1920×1080PsF
YPbPr 1.5G

1920×1080PsF
YPbPr 1.5G

1920×1080P
YPbPr 1.5G

SDI 4
No output
1920×1080P
YPbPr 1.5G
1920×1080P
YPbPr 1.5G
No output
1920×1080P
YPbPr 1.5G
1920×1080P
YPbPr 1.5G
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MONITOR OUT Connector/HDMI OUT Connector Output Formats
The digital signal from the MONITOR OUT and HDMI OUT connectors is output according to the Project category and Monitoring category settings in the menu.
For details about Project category settings combinations, see “Recording Format Settings” (page 39).
Default values are shown underlined and in bold text.
Project
Project Frame Rate
59.94/50

Imager Mode
4K 17:9

3.8K 16:9

29.97/25

Monitoring > Output Format
SDI 1/2
SDI 3/4

Monitor

4096×2160P 2SI

4096×2160P 2SI

1920×1080i

4096×2160P Square
2048×1080P
1920×1080P
1920×1080i

4096×2160P Square
1920×1080i
1920×1080i
1920×1080i

1920×1080i
1920×1080i
1920×1080i
1920×1080i

3840×2160P 2SI

1920×1080i

3840×2160P Square
1920×1080P
1920×1080i

3840×2160P Square
1920×1080i
1920×1080i

1920×1080i
1920×1080i
1920×1080i
1920×1080i

1920×1080i

1920×1080i

4096×2160P 2SI

–

1920×1080PsF

4096×2160P Square
2048×1080PsF
1920×1080PsF

4096×2160P Square
1920×1080PsF
1920×1080PsF

1920×1080PsF
1920×1080PsF
1920×1080PsF

–

1920×1080PsF

3840×2160P Square
1920×1080PsF

1920×1080PsF
1920×1080PsF

1920×1080PsF
1920×1080PsF
1920×1080PsF

1920×1080PsF

1920×1080PsF

1920×1080PsF

4096×2160P 2SI

–

1920×1080P

4096×2160P Square
2048×1080P
1920×1080P

4096×2160P Square
1920×1080P
1920×1080P

1920×1080P
1920×1080P
1920×1080P

XAVC-I QFHD Class300/
3840×2160P 2SI
Rec Off

4K 17:9/
3.8K 16:9

MPEG 1920×1080i

4K 4:3/4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

4K 17:9/
3.8K 16:9

XAVC-I QFHD Class480/
XAVC-I QFHD Class300/ 3840×2160P 2SI
Rec Off
3840×2160P Square
1920×1080PsF
MPEG 1920×1080P
1920×1080PsF

6K 3:2/
4K 4:3/
4K 17:9

XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

3.8K 16:9

24

SxS Rec Format
XAVC-I 4K Class300/
Rec Off

–

HDMI
4096×2160P
1920×1080i
1920×1080i
1920×1080i
1920×1080i
1920×1080i
3840×2160P
1920×1080i
1920×1080i
1920×1080i
1920×1080i
1920×1080i
720×480P 1) 2)
720×576P 1) 3)
4096×2160P
1920×1080PsF
1920×1080PsF
1920×1080PsF
1920×1080PsF
3840×2160P

4096×2160P
1920×1080P
1920×1080P
1920×1080P
1920×1080P

Output format
Monitor Out
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
1920×1080i YPbPr 1.5G
No output
No output
1920×1080PsF YPbPr 1.5G
1920×1080PsF YPbPr 1.5G
1920×1080PsF YPbPr 1.5G
1920×1080PsF YPbPr 1.5G
1920×1080PsF YPbPr 1.5G

HDMI
4096×2160P
1920×1080i
1920×1080i
1920×1080i
1920×1080i
1920×1080i
3840×2160P
1920×1080i
1920×1080i
1920×1080i
1920×1080i
1920×1080i
720×480P
720×576P
4096×2160P
1920×1080PsF
1920×1080PsF
1920×1080PsF
1920×1080PsF
3840×2160P

1920×1080PsF YPbPr 1.5G
1920×1080PsF YPbPr 1.5G

1920×1080PsF
1920×1080PsF
1920×1080PsF

1920×1080PsF YPbPr 1.5G

1920×1080PsF

1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G

4096×2160P
1920×1080P
1920×1080P
1920×1080P
1920×1080P
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Project
Project Frame Rate
23.98

SxS Rec Format
XAVC-I 4K Class480/
XAVC-I 4K Class300/
Rec Off

3.8K 16:9

XAVC-I QFHD Class480/
3840×2160P 2SI
XAVC-I QFHD Class300/
Rec Off
3840×2160P Square
1920×1080P
MPEG 1920×1080P
1920×1080P

4K 4:3/
4K 17:9/
3.8K 16:9
1)
2)
3)

Monitoring > Output Format
SDI 1/2
SDI 3/4

Imager Mode
6K 3:2/
4K 4:3/
4K 17:9

Monitor

HDMI
4096×2160P

4096×2160P 2SI

–

1920×1080P

4096×2160P Square
2048×1080P
1920×1080P

4096×2160P Square
1920×1080P
1920×1080P

1920×1080P
1920×1080P
1920×1080P

–

1920×1080P

3840×2160P Square
1920×1080P

1920×1080P
1920×1080P

1920×1080P
1920×1080P
1920×1080P
1920×1080P
3840×2160P
1920×1080P
1920×1080P
1920×1080P

1920×1080P

1920×1080P

1920×1080P

When AXS Rec Format is set to Rec Off, this output is selected when Technical > System Configuration > SD HDMI is set to On in the menu
When Project Frame Rate is 59.94.
When Project Frame Rate is 50.0.

Output format
Monitor Out
1920×1080P YPbPr 1.5G

HDMI
4096×2160P

1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G

1920×1080P
1920×1080P
1920×1080P
1920×1080P
3840×2160P
1920×1080P
1920×1080P
1920×1080P

1920×1080P YPbPr 1.5G

1920×1080P

1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G
1920×1080P YPbPr 1.5G
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Error/Warning Indications
If a warning, caution, or operating condition that requires confirmation occurs on the unit, a message is
displayed on the sub display, the REC lamp starts flashing, and a warning sound is emitted.
The buzzer is output to the built-in speaker or to the headphones connected via the headphone
connector.
When the unit is turned on, a message appears on the sub display screen prompting you to execute APR
if the auto adjustment for the image sensor (APR) has not been performed for a certain period of time. In
this case, follow the on-screen instructions to execute APR (page 49).

Warning display
Buzzer
indication
Insufficient Voltage 1) Continuous
EXT. I/F Signal Error

–

AXS Recorder Temp. –
High 1)

Error Display

1)

REC lamp

Cause and Solution

High-speed
flashing
–

The DC IN voltage is too low. Recording is disabled.
Connect another power source.
An error was detected with the signal on the mounting
terminal for an expansion unit.
Check the connection to the AXS-R7 or other device.
The internal temperature of the AXS recorder is high.
Turn off the unit and allow it to cool down before
operating it again.

–

Message is not displayed on the monitor screen.

The unit will stop operation when the following kind of display occurs.
Error display
indication
E + Error code

Buzzer

REC lamp

Cause and Solution

Intermittent

High-speed
flashing

The unit may be defective. Recording stops even if
REC is displayed on the viewfinder screen.
Turn off the power and check the connected
equipment, cables, and media. If the error persists when
the unit is turned on again, contact your Sony service
representative. (If power cannot be turned off by setting
the power switch to OFF, remove the battery pack or
the DC IN source.)

Caution and Operation Confirmation Display
The following caution and operation confirmation messages may appear on the monitor screen or sub
display, and warning icons may be displayed and messages displayed in the Info category > Camera
Condition in the menu. Follow the instructions provided to resolve the issue.
Display indication
Battery Error
Please Change Battery
Backup Battery End
Please Change
Cannot Use SxS(A)*
Please Change

Warning Display
When one of the following messages occurs, use the following table to resolve the problem.
Warning display
indication
Media Full 1)

Buzzer

REC lamp

Cause and Solution

Continuous

High-speed
flashing

Battery End 1)

Continuous

Temperature High 1)

Intermittent

High-speed
flashing
Flashing

Clips could not be recorded, copied, or split because
there is no remaining capacity on the SxS memory card.
Replace immediately.
The battery pack is dead. Recording is disabled.
Stop operation and recharge the battery pack.
The internal temperature is high.
Turn off the unit and allow it to cool down before
operating it again.

Cannot Use SxS(A)*
Unsupported File System

Media Error
SxS(A)* Needs to be Restored
SxS(A)* Error
Recording Halted
Playback Halted

Cause and Solution
An error was detected in the battery pack.
Replace with a normal battery pack.
The remaining capacity of the backup battery is
insufficient.
Replace the backup battery.
A memory card that has been partitioned or a
memory card containing more clips that can be
handled by the unit was inserted.
The card cannot be used in the unit, and must be
replaced.
A card using a different file system or an unformatted
card was inserted.
The card cannot be used in the unit, and must be
replaced or formatted using the unit.
An error occurred with the memory card. The card
requires restoration.
Restore the card.
Recording or playback stopped because an error
occurred on the memory card.
If the problem persists, replace the memory card.
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Display indication
Input AES/EBU is Invalid Emphasis

Input AES/EBU is not Pro Use

Fan Stopped

AXS Recorder Fan Stopped

Unsupported FPS
Change AXS(A) to AXS S48 Memory

Abnormal Lens Communication
Please Check “Lens IF” Setting

Please Execute APR

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again
XXXX License Y days Remaining
(XXXX: Type of license, Y: Number of days remaining)

Cause and Solution
Emphasis signal that is not compatible with the AES/
EBU input was input.
The unit is compatible with 50u-15u Emphasis only.
A signal other than Professional Use was input to the
AES/EBU input.
The unit is compatible with Professional Use only.
The fan in the unit has stopped.
Avoid use under high temperature conditions. Turn
the unit off and contact a Sony service representative.
The fan in the AXS-R7 that is connected to the unit
has stopped.
Avoid use under high temperature conditions.
Remove the AXS-R7 from the unit and contact a Sony
service representative.
Unsupported AXS memory was detected.
Recording cannot be performed. Change the
recording format for the AXS memory card, or change
the card to an AXS-A512S48 or AXS-A1TS48.
The type of the connected lens does not match the
unit’s setting.
Check the Technical > System Configuration > Lens
Interface setting in the menu.
The auto adjusting of the image sensor (APR) has not
been executed for a certain period.
Execute APR by pressing the MENU dial.
The setting of Clip Naming was reset because an
invalid All-settings file is loaded.
Save the All-settings file again after setting the desired
values.
There are 2 days remaining before the license for the
software option will expire.

* “SxS(B)” is displayed for the SxS memory card in slot B, “AXS(A)” is displayed for the AXS memory card in slot A of the AXS-R7,
and “AXS(B)” is displayed for the AXS memory card in slot B of the AXS-R7.
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Items Saved in Files
Table legend
Yes: Saved
No: Not saved
–: Not saved (temporary setting)

Project Menu

Shooting Menu
Item

Sub-item

Shutter 1)

Shutter Select
Step/Cont. Select
Add/Change Step
Delete Step
ND Position
EI Select
Color Temp. Select
Add/Change Step
Delete Step
SDI 1/2
SDI 3/4
Monitor
HDMI
VF LUT
SxS Rec
Sub Rec
Category
Preset Look Select

ND
Exposure Index
White Balance 1)

LUT Select

Look
1)

Selection options added or edited by a user are also saved.

File type
All
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
–
Yes

Item

Sub-item

Basic Setting

Imager Mode
Project Frame Rate
AXS Rec Format
SxS Rec Format
Sub Rec Format
SxS/Output De-Squeeze
<1>
<2>
<3>
<4>
<User 1>
<User 2>
<User 3>
<User 4>
<User 5>
Load SD Card
Save SD Card
File ID
Format SD Card

Assignable Button

All File

File type
All
Yes
Yes
Yes
Yes
Yes
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
–
–
Yes
–
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TC/Media Menu
Item
Timecode

Clip Name Format

Format Media

Update Media

Monitoring Menu
Sub-item

File type

Mode
Manual Setting
Reset
TC Format
TC Source
Time Data Display
Camera ID
Reel Number
Camera Position
AXS Slot A
AXS Slot B
SxS Slot A
SxS Slot B
SD Card
AXS Slot A
AXS Slot B
SxS Slot A
SxS Slot B

All
Yes
–
–
Yes
–
Yes
Yes
Yes
Yes
–
–
–
–
–
–
–
–
–

Item

Sub-item

Output Format

SDI 1/2
SDI 3/4
Monitor
HDMI
Status Info
Status Info Select
Frame Line
Frame Line Select
Status Info
Status Info Select
Frame Line
Frame Line Select
Status Info
Status Info Select
Frame Line
Frame Line Select
OSD Status
Project
Timecode
Audio Level Meter
Look Status
Output LUT
Recording LUT
VF Status
Lens Status
Project
Timecode
Audio Level Meter
Look Status
Output LUT
Recording LUT
VF Status
Lens Status
Focus Distance Format

VF OSD

SDI OSD

Monitor OSD

HDMI OSD
Status Info A

Status Info B

Display Info

File type
All
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
–
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
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Item

Sub-item

Frame Line A

Center Marker
Aspect Ratio
Aspect Safety Zone
Picture Area
Safety Zone
User Frame Line
Center Marker
Aspect Ratio
Aspect Safety Zone
Picture Area
Safety Zone
User Frame Line
Color
Center Marker
Safety Area
Aspect Ratio Type
Aspect Ratio Select
Aspect Ratio Mask
Aspect Safety Area
Frame Line on Playback
Width
Height
H Position
V Position
VF LUT
Status Info
Status Info Select
Frame Line
Frame Line Select
Color
Double Speed Scan
Peaking Frequency
Zebra
Zebra Select
Zebra1 Level
Zebra1 Aperture Level
Zebra2 Level

Frame Line B

Frame Line

User Frame Line

VF Display

VF Function

File type
All
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Audio Menu
Item

Sub-item

Audio Input

CH-1 Audio Select
CH-2 Audio Select
CH-1 Audio Level
CH-2 Audio Level
MIC Reference
Monitor CH
Monitor Level
Input Limiter Mode
AGC Level
AGC Mono/Stereo
MIC Input Mono/Stereo
Phantom Power +48V
Monitor Output CH Pair
Headphone Mono/ST

Audio Monitor
Audio Configuration

File type
All
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
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Technical Menu

Maintenance Menu

Item

Sub-item

Test Signals

Color Bars
Color Bars Type
1kHz Tone on Color Bars
Test Saw

File type
All
Yes
Yes
Yes
Yes

Switch & Rec Light

Lock Operator Side

Yes

Lock Assistant Side
Rec Light
Rec Start/Stop Beep
Fan Control
Lens Interface
SDI Rec Remote Trigger
SD HDMI
Shutter Mode
APR
Reset
Near End:Info Battery
End:Info Battery
Near End:Sony Battery
End:Sony Battery
Near End:Other Battery
End:Other Battery
Detected Battery
DC Low Voltage1
DC Low Voltage2
DC(24V) Low Voltage1
DC(24V) Low Voltage2
Brightness level
Input Source
Reference Lock Type

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
–
–
Yes
Yes
Yes
Yes
Yes
Yes
–
Yes
Yes
Yes
Yes
Yes
Yes
–

System Configuration

APR
Battery

DC Voltage Alarm

Control Display
Genlock

Item

Sub-item

Clock Set

Time Zone
Date Mode
Date
Time
Select
Camera(System)
R7 Recorder(System)
Camera(Resettable)
R7 Recorder(Resettable)
Reset-Cam(Resettable)
Reset-R7(Resettable)
Reset
Install: xxx
Anamorphic
Full Frame
Unique Device ID
Camera
AXS
FW Update-camera

Language
Hours Meter

Reset to Default
License Options

Firmware

File type
All
Yes
Yes
–
–
Yes
–
–
–
–
–
–
–
–
–
–
–
–
–
–
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Licenses
MPEG-4 Visual Patent Portfolio
License
THIS PRODUCT IS LICENSED UNDER THE MPEG-4
VISUAL PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A
CONSUMER FOR
(i) ENCODING VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”)
AND/OR
(ii) DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL AND NON-COMMERCIAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO.
NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE. ADDITIONAL INFORMATION
INCLUDING THAT RELATING TO PROMOTIONAL,
INTERNAL AND COMMERCIAL USES AND
LICENSING MAY BE OBTAINED FROM MPEG LA,
LLC. SEE HTTP://WWW.MPEGLA.COM
MPEG LA is offering licenses for (i) manufacturing/
sales of any storage media storing MPEG-4 Visual
video information (ii) distribution/broadcasting of
MPEG-4 Visual video information in any manner
(such as online video distribution service, internet
broadcasting, TV broadcasting).
Other usage of this product may be required to
obtain license from MPEGLA. Please contact MPEG
LA for any further information. MPEG LA. L.L.C., 250
STEELE STREET, SUITE 300, DENVER, COLORADO
80206
http://www.mpegla.com

MPEG-4 AVC Patent Portfolio License
THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL
USE OF A CONSUMER OR OTHER USES IN WHICH IT
DOES NOT RECEIVE REMUNERATION TO
(i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC
STANDARD (“AVC VIDEO”) AND/OR
(ii) DECODE AVC VIDEO THAT WAS ENCODED BY
A CONSUMER ENGAGED IN A PERSONAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO.
NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE. ADDITIONAL INFORMATION
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE
HTTP://WWW.MPEGLA.COM

On Accessing Software to which the
GPL/LGPL Applies
This product uses software to which the GPL/LGPL
applies. This informs you that you have a right to
have access to, modify, and redistribute source
code for these software programs under the
conditions of the GPL/LGPL.
The source code is provided on the internet.
Use the following URL and follow the download
instructions.
http://www.sony.net/Products/Linux/common/
search.html
We would prefer that you do not contact us about
the contents of the source code.
For the content of these licenses, see “License1.
pdf” in the “License” folder of the supplied CDROM.
Adobe Reader must be installed on your computer
to view PDF files.
If Adobe Reader is not installed on your computer,
you can download it by accessing the following
URL.
http://get.adobe.com/reader/

Open Software Licenses
On the basis of license contracts between Sony
and the software copyright holders, this product
uses open software.
To meet the requirements of the software
copyright holders, Sony is obligated to inform you
of the content of these licenses.
For the content of these licenses, see “License1.
pdf” in the “License” folder of the supplied CDROM.
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Specifications
General Specifications
Mass

Approx. 3.9 kg (8 lb 9.6 oz) (excluding
handle, VF attachment, bottom
cover)

Dimensions
See page 77.
Power requirements
12 V DC (11 V to 17 V)
24 V DC (22 V to 32 V)
Power consumption
Approx. 60 W (when recording XAVC)
Operating temperature
0 °C to 40 °C (32 °F to 104 °F)
Storage temperature
–20 °C to +60 °C (–4 °F to +140 °F)
Continuous operating time
Approx. 60 minutes (using BP-FLX75)
Recording format (video)
RAW SQ (4K,17:9)
(when the AXS-R7 is attached)
X-OCN ST (6K 3:2, 4K 4:3, 4K 17:9)
(when the AXS-R7 is attached)
X-OCN LT (6K 3:2, 4K 4:3, 4K 17:9)
(when the AXS-R7 is attached)
XAVC-I Class480 (4K, QFHD)
XAVC-I Class300 (4K, QFHD)
MPEG HD422 (HD)
Recording format (audio)
LPCM 8CH (2CH recording/playback),
24-bit, 48 kHz
Recording frame rate
RAW SQ (when the AXS-R7 is attached):
4K 17:9/3.8K 16:9
59.94P/50P/29.97P/25P/24P/
23.98P
X-OCN (when the AXS-R7 is attached):
6K 3:2
24P/23.98P
4K 4:3
24P/23.98P
4K 17:9/3.8K 16:9
59.94P/50P/29.97P/25P/24P/
23.98P

XAVC-I Class480:
4K: 4096×2160
29.97P/25P/24P/23.98P
QFHD: 3840×2160
29.97P/25P/ 23.98P
XAVC-I Class300:
4K: 4096×2160
59.94P/50P/29.97P/25P/24P/
23.98P
QFHD: 3840×2160
59.94P/50P/29.97P/25P/23.98P
MPEG HD422(50Mbps):
HD: 1920×1080
29.97P/25P/23.98P/59.94i/50i
Recording/playback time
XAVC-I Class480 23.98P
Approx. 34 minutes when using
SBP-128B/C/D
XAVC-I Class300 23.98P
Approx. 54 minutes when using
SBP-128B/C/D
MPEG2 HD422
Approx. 108 minutes when using
SBS-64G1A/B
[Note]

The recording and playback times are for a continuous
recording as a single clip. The actual times may be shorter,
depending on the number of clips recorded. The recording/
playback time may vary due to usage conditions and
memory characteristics.

Camera

Input/Output

Imaging device
35 mm full size, single-chip CMOS
image sensor
Number of pixels
24.8 M (total)
Built-in filters

Audio input
CH-1/CH-2: XLR-type 5-pin (female) (1),
LINE / AES/EBU / MIC / MIC+48V
selectable
DC input
XLR-type 4-pin (male), 11 V to 17 V or
22 V to 32 V DC
DC output (12 V)
Hirose 4-pin (1),
11 V to 17 V DC (Output voltage:
Same as input voltage, Maximum
output current: 1.0 A),
22 V to 32 V DC (Output voltage:
15 V, Maximum output current:
0.8 A),
Using battery adaptor

ND filter A
Clear
ND filter B

Clear

Clear

0.9
(1/8)
1.8
(1/64)

0.9
(1/8)
1.8
(1/64)

0.3
(1/2)
0.3
(1/2)
1.2
(1/16)
2.1
(1/128)

0.6
(1/4)
0.6
(1/4)
1.5
(1/32)
2.4
(1/256)

[Notes]

ISO sensitivity
ISO 500 (D55 light source)
Lens mount
PL mount (with lens mount adaptor)
Flange focal length
52 mm
Latitude
15+ stops

ˎˎ You can output a REC Tally signal and input a REC Trigger
signal through the 12V OUT connector.
ˎˎ Connect to the 12V OUT connector only devices with
current consumption of 1.0 A or lower when the input
voltage is 11 V to 17 V, or 0.8 A or lower when the input
voltage is 22 V to 32 V.

DC output (24 V)
Fischer 3-pin (2),
11 V to 17 V DC (Output voltage:
24 V, Maximum output current:
1.0 A),
22 V to 32 V DC (Output voltage:
Same as input voltage, Maximum
output current: 2.0 A)
[Note]
Connect to the 24V OUT connector only devices with current
consumption of 1.0 A or lower when the input voltage is
11 V to 17 V, or 2.0 A or lower when the input voltage is 22 V
to 32 V.

SDI output BNC type (4)
3G-SDI: SMPTE ST424/425 Level B-DL/DS
HD SDI: SMPTE ST292 compliant
AUX
LEMO 5-pin (1)
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Viewfinder output
LEMO 26-pin (1)
Network
RJ45 type (1)
Remote control
8-pin (1)
MONITOR output
BNC type (1)
HD SDI: SMPTE ST292 compliant
Timecode input
TC IN: BNC type (1)
GENLOCK input
BNC type (1)
HDMI output
Type A (1)
External device connector
USB host: Type A (1)
Headphones output
Stereo mini jack (1)
Speaker output
Monaural

Media Slots
Type

ExpressCard/34 slot (2)
SD card slot (1)

Supplied Accessories
VF attachment (1)
Handle (1)
VF cable (1)
Shim (circular) (1)
Shim (1/3 arc) (15)
Lens mount cover (1)
Before Using this Unit (1)
Operating Instructions (CD-ROM) (1)

Optional Accessories
0.7-inch type viewfinder
DVF-EL200
7-inch type viewfinder
DVF-L700
VF cable for attaching DVF-L700
A-2201-632-A or A-2201-633-A
Portable Memory Recorder
AXS-R7
SxS memory cards (SxS-1/SxS Pro/SxS Pro+)
SBP-256D, SBP-128B/C/D, SBP-64A/B/
C/D, SBP-32G1A/B
Card Reader
SBAC-US30, SBAC-UT100, AXS-AR1
Shoulder Adaptor (attaches to VCT-14 using V shoe)
VCT-FSA5
PL mount lens
SCL-PK6/F (Feet), SCL-PK6/M (Meters)
(6-lens kit: 20, 25, 35, 50, 85, 135
mm),
SCL-P11X15 (11 mm to 16 mm
zoom)
Battery Pack
BP-FL75, BP-FLX75
AC Adaptor
AC-DN2B, AC-DN10
Microphone
ECM-680S, ECM-678*, ECM-674*
(*: EC-0.5X3F5M 3-pin XLR to 5-pin
XLR adaptor cable required)
Dual Battery Adaptor
BKW-L200 (connection via battery
connection adaptor)
SDI/HDMI Monitor
BVM series, PVM series, LMD series
XQD memory cards (QDA-EX1 XQD to SxS
ExpressCard Adaptor required)
QD-S64E, QD-S32E, QD-N64, QDG128A, QD-G64A, QD-G32A
Design and specifications are subject to change
without notice.

Notes
ˎˎAlways make a test recording, and verify
that it was recorded successfully. SONY
WILL NOT BE LIABLE FOR DAMAGES OF ANY
KIND INCLUDING, BUT NOT LIMITED TO,
COMPENSATION OR REIMBURSEMENT ON
ACCOUNT OF FAILURE OF THIS UNIT OR ITS
RECORDING MEDIA, EXTERNAL STORAGE
SYSTEMS OR ANY OTHER MEDIA OR STORAGE
SYSTEMS TO RECORD CONTENT OF ANY TYPE.
ˎˎAlways verify that the unit is operating
properly before use. SONY WILL NOT BE LIABLE
FOR DAMAGES OF ANY KIND INCLUDING,
BUT NOT LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF THE LOSS
OF PRESENT OR PROSPECTIVE PROFITS DUE
TO FAILURE OF THIS UNIT, EITHER DURING THE
WARRANTY PERIOD OR AFTER EXPIRATION OF
THE WARRANTY, OR FOR ANY OTHER REASON
WHATSOEVER.
ˎˎSONY WILL NOT BE LIABLE FOR CLAIMS OF
ANY KIND MADE BY USERS OF THIS UNIT OR
MADE BY THIRD PARTIES.
ˎˎSONY WILL NOT BE LIABLE FOR THE LOSS,
REPAIR, OR REPRODUCTION OF ANY DATA
RECORDED ON THE INTERNAL STORAGE
SYSTEM, RECORDING MEDIA, EXTERNAL
STORAGE SYSTEMS OR ANY OTHER MEDIA OR
STORAGE SYSTEMS.
ˎˎSONY WILL NOT BE LIABLE FOR THE
TERMINATION OR DISCONTINUATION OF ANY
SERVICES RELATED TO THIS UNIT THAT MAY
RESULT DUE TO CIRCUMSTANCES OF ANY
KIND.
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Dimensions

Trademarks
25 (1)
25 (1)
25 (1)
25 (1)
15.2 (5/8)

Unit: mm (inches)

10-UNC 3/8-16×10.7

147 (5 7/8)

27.7 (1 1/8)
25 (1)
25 (1)

10-UNC 1/4-20×10.7

25 (1)
17 (11/16)

4.45 (3/16)

236
(9 3/8)

2-M3×5

158
(6 1/4)

2-M3×5

170 (6 3/4)

40 (1 5/8)

235 (9 3/8)
25 (1)
25 (1)
13 (17/32)

UNC 1/4-20×11

Ø5.2×5
UNC 1/4-20×10.5

2-UNC 3/8-16×10.5
0.5 (1/32)
25 (1)
25 (1)
25 (1)

2-UNC 3/8-16×13.5

are registered trademarks of
ˎˎXAVC and
Sony Corporation.
ˎˎThe terms HDMI and HDMI High-Definition
Multimedia Interface, and the HDMI Logo are
trademarks or registered trademarks of HDMI
Licensing LLC in the United States and other
countries.
ˎˎAll system names and product names are
registered trademarks or trademarks of their
respective owners. Trademarked items are not
indicated by ® or ™ symbols in this document.

